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ABOUT THIS GUIDE

This document covers essential processes and procedures for ANZ Transactive Administrators and Users. It is recommended
that Administrators and Users read this guide in conjunction with the Terms Governing the Use of ANZ Transactive.

LEARNING ABOUT ANZ TRANSACTIVE

The following range of resources are available to assist you in your use of ANZ Transactive.

1. ONLINE HELP

The online help should be your primary source of information about using ANZ Transactive.

As new operating features or functions, particularly those relating to security, integrity and authentication are introduced,
instructions covering changes and the usage of such features will be provided.

As shown below, there are two ways to access ANZ Transactive help.

1. The Help button at the top of the page provides a complete online help index for the majority of ANZ Transactive functions.
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Click the ? button
and the help screen
will appear as shown




2. The @ button provides a help function for the specific page you are accessing.

Click the ? button
and the help screen
will appear as shown
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2. GENERAL SYSTEM NAVIGATION INFORMATION
To navigate through ANZ Transactive simply use the page controls available within the system. It is recommended you do not
use the controls on your browser’s toolbar (such as Back, Forward and Refresh) to navigate through the system.

General system navigation information is also provided within the ANZ Transactive help. See the Navigating the System section
of the ANZ Transactive help.

3. SUPPORT INFORMATION

When you first log on to ANZ Transactive, your home page appears. To view ANZ contact numbers and updates about the
system, click the View Support Information button.
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MINIMUM SPECIFICATIONS

Below are the list of specifications required to access ANZ Transactive.

OPERATING SYSTEM
The following five operating systems are supported for Token User and Users ID/password Users:

> Windows Microsoft 7

> Windows Microsoft Vista
> Windows Microsoft XP

> Windows Microsoft 2000
> Windows Microsoft NT

FIREWALL AND ANTIVIRUS SETTINGS

Please ensure the appropriate permissions are configured for both firewall and antivirus software to allow users to access
ANZ Transactive.

OPERATING SYSTEM AND BROWSER VERSION
Below is the summary of compatible operating systems and browser versions for Token Users.

BROWSER TYPE & JAVA VIRTUAL WINDOWS XP

VERSION MACHINE WINDOWS PROFESSIONAL WINDOWS  WINDOWS
(JVM) WINDOWS 7 VISTA SP1/SP2/SP3 2000 NT

Microsoft Internet MS 5.00.3802

Explorer 6.0 (SP1 & SP2) SUNT420 Supported Supported Supported Supported Supported

Microsoft Internet MS 5.00.3802

Explorer 7.0 SUN14.2.0 Supported Supported Supported Supported Supported
SUNT1.5.20

Microsoft Internet MS 5.00.3802

Explorer 8.0 SUN14.2.0 Supported Supported Supported Supported Supported
SUNT.5.2.0

Apple Mac / Safari is currently supported.

INTERNET CONNECTION
An internet speed of 56kbps or higher is recommended.

VIDEO RESOLUTION
A minimum screen resolution of 800 x 600 is recommended.

ACCESS REQUIREMENTS
Token Users:

There are no specific access requirements for Token Users.



HARDWARE REQUIREMENTS
Token Users and User ID/password Users:

> Token (provided by ANZ) No specific access requirements.

ANZ TRANSACTIVE SECURITY INFORMATION

The following security is in place to protect your organisation when using ANZ Transactive.

PHYSICAL SECURITY

All buildings that contain ANZ Transactive web servers and/or database servers use industry-standard physical security to prevent
access by unauthorised people.

DATA ENCRYPTION

All data communication to and from ANZ Transactive uses 128-bit Secure Sockets Layer encryption and HTTPS (Hypertext Transfer
Protocol - Secure) as communication protocol.

FIREWALLS

Firewalls protect all data used in ANZ Transactive. Firewalls assist to ensure that data is only provided in response to valid requests
from the application. It is advisable for your organisation to also have a firewall to protect its own computers and networks.

It is recommended that antivirus and anti-spyware software are installed on computers, particularly when linked to a broadband
connection, digital subscriber line or cable modem. It is recommended to update anti-virus and firewall products with security
patches or new versions on a regular basis.

AUTHENTICATION

ANZ Transactive will verify the identity of each User accessing ANZ Transactive by the following three authentication methods:
> User ID/password

> A Vasco Digipass Token / RSA Token or

To authenticate a User the following action is taken:

> Determine the type of User, and verify the User’s identity

> Confirm the User is permitted access ANZ Transactive

Once authenticated the User’s functionality is controlled by the assigned security profile, which is discussed in the Security
Profiles section.



SECURITY PROFILES
An Administrator assigns a security profile for all Users, excluding Authorisers on ANZ Transactive.

> A security profile determines which module of ANZ Transactive Users can access

> The functions Users can use within each module of ANZ Transactive

THRESHOLD GROUPS

If your use of ANZ Transactive involves authorising transactions, then your organisation’s Administrator may have assigned you a
threshold group.

Your threshold group determines the value of transactions that you can authorise. For each type of transaction, there are limits
for the:

> Threshold amount, which is the largest single transaction you can authorise

> Daily maximum value of the transactions you can authorise

TEMPLATE GROUPS

If your use of ANZ Transactive involves initiating/creating transactions then your Administrator may of assigned you one or more
Template Groups. The Template Group assigned to you will determine which type of Instruments you can create.

CONFIDENTIAL PAYMENT INDICATOR

A Confidential Payment Indicator may of been assigned to your User profile by your Administrator enabling you to have access to
confidential payment transactions and templates.

PANEL AUTHORITY

If your use of ANZ Transactive involves authorising payment transactions, then your organisation’s Administrator may have
assigned you a panel authority.

Your panel authority determines the value of the transactions that you can authorise and your panel User group. For each account
provided, there is a limit assigned to each User and which panel User must authorise the transaction.

SEGREGATION OF DUTIES

ANZ Transactive allows your organisation to enforce segregation of duties between employees, which provides an additional form
of security. For example:

> Transactions may need to be authorised by someone other than the last person who entered data for those transactions

> Transactions for some types of instruments may require multiple authorisations (e.g. via a panel authorisation)

REPORTING CATEGORIES

> ANZ Transactive allows the ability to assign users to reports based on their roles and responsibilities within your organisation.
Five report categories (Cash Payments, Trade Services, Confidential, Term Deposit and Administrator) will be available to users and
can be Assigned to users via their user profile page. Only reports within that selected category will be available to the user from the
Reports navigational tab. User’s can have up to all four categories assigned to them.



ANZ TRANSACTIVE SECURITY DEVICES

HOW YOUR RSA TOKEN WORKS
Your RSA Token generates a new six digit number — known as an RSA Token Code - every 60 seconds.

Each Code can only be used once. Only the Code that currently appears on the screen is valid. The countdown bar on the left hand
side of the screen shows you how much time you have left until a new Code is generated, by shrinking one block every 10 seconds
as it counts down.

Code generation for each RSA Token is completely random, so no two devices will display the same Code at the same time.

Token
Code

Countdown bar

You will need to use your RSA Token each time you log on to ANZ Transactive. You will also need to use your RSA Token Code if you
authorise a Cash or Trade transaction. When prompted enter the six digit RSA Token Code that appears on the screen of your RSA
Token at that time. ANZ will verify this Code as part of your log on process.

If you enter the RSA Token Code incorrectly, you will be asked to enter a new Code to successfully log on.

Your RSA Token has a serial number on the back of the device. This number is unique to your RSA Token.

Serial
number

Before you can log on to ANZ Transactive, you need to activate your RSA token. You will need to quote the serial number to link
your RSA Token to your ANZ Transactive User ID.

HOW YOUR VASCO DIGIPASS TOKEN WORKS

Your Vasco Digipass Token will first need to be activated by the ANZ Transactive Support Team. You will be required to turn on your
device by pressing the arrow button on the bottom right and then while pressing the arrow button press the lock button on the
bottom left of the device. The device will remain turned on for 20 seconds only from last use. i.e. last button pressed.

Prior to initial token activation a‘’LOCK PIN'number will be displayed on the screen. Upon providing the LOCK PIN number to

your ANZ Transactive Support Team, the team will in turn provide an UNLOCK PIN. By selecting the arrow button again and
entering the UNLOCK PIN, the device will prompt the user to enter in a six-digit NEW PIN and re-enter to confirm. Once successful,
the NEW PIN will be the user’s PIN to unlock the device to use going forward.



If you enter the incorrect PIN when unlocking the token with your PIN, it will display the word FAIL and number of failed attempts.
Press the back arrow button to re-enter your PIN, though please note after 5 incorrect PIN attempts the token will become blocked.

In the event that you disable your token after five invalid consecutive attempts, you can contact the ANZ Transactive Support Team
to have your Vasco Digipass Token PIN reset. Note this is not offered in Singapore due to regulatory requirements therefore any
disabled token will require to be replaced.

When logging into ANZ Transactive, you will be required to unlock your device with your PIN and select option 1 for OTP
(One Time Password). The random number generated on the device will be the Token OTP to access ANZ Transactive.
This OTP must be entered into the log on page together with your password.

HOW TO AUTHENTICATE A TRANSACTION USING A VASCO DIGIPASS TOKEN AND SIG (ONLINE SIGNING):

> Upon selecting the Authorise button on a completed transaction within ANZ Transactive, you need to unlock your token and
select option 2 (SIG) on your Vasco Digipass Token. You will then be prompted to enter in the six-digit Key Information as indicated
on the Sign Transaction page of the ANZ Transactive transaction into the Vasco Digipass token then press the back arrow button on
the token. Upon selecting the arrow button, the device will return a Signature Code to then be entered into the Sign Transaction
page in ANZ Transactive.

PROTECTING YOUR BANKING
> Users should check the authenticity of the financial institution’s website prior to accessing available products and services

> Users should verify when accessing products and services offered by the financial institution that the browser session is secure.
This can be verified by ensuring the webpage begins with “https://” rather than “http://’, and the security lock is displayed on the
bottom right of the browser. Users should not commence transactions prior to verifying

> Always log out of ANZ Transactive by using the log out button in the top right hand corner of the browser
> Do not install software or run programs of unknown origin

> Delete junk or chain emails

> Do not open email attachments from unknown senders

> Do not disclose personal, financial or credit card information to suspect websites or unknown recipients

> Do not use a computer or a device which cannot be trusted

> Do not use public or internet café computers to access banking products and services

> Do not share resources from your computer, (i.e. hard drives and printers) whilst operating on the internet
> Do not disclose your password or security device passphrase to anyone else

> If your Token is lost or stolen you must notify the ANZ Transactive Support Centre immediately to have the Token suspended
or revoked
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KEY CONCEPTS AND TERMS

This section outlines the key concepts and terms to assist you in using ANZ Transactive.

MESSAGES

In ANZ Transactive, a message is an electronic communication between ANZ and a client in relation to a transaction.
ANZ Transactive has its own online messaging system that enables you to:

> Send mail messages to ANZ and other Users in your organisation
> Receive notifications from ANZ for transactions relating to instruments you've initiated using ANZ Transactive

For more information, see Working with Messages

TRANSACTIONS /INSTRUMENTS
A transaction is a term used to define Cash Payments such as Transfer between Accounts, RTGS, Cross Border Funds Transfer etc.

An Instrument is a term used to define Trade activities such as Import Letters of Credit, Guarantees, etc.

CREATING A TRANSACTION /INSTRUMENT
You can create a transaction / instrument in the following ways:

> Using a‘blank’template

> Using a’predefined’ template

> Copying from an existing transaction/instrument

> Create an instrument from an existing trade transaction.

For more information on using transactions, see Working with Payment Transactions.

ORGANISATION SUBSIDIARIES
When an organisation is added to ANZ Transactive, subsidiary organisations can be assigned to the parent organisation.

Using ANZ Transactive subsidiary access you can route messages and transactions to:
> A particular User in any of your subsidiary organisations within your organisation hierarchy

To register for a subsidiary organisations please contact your local ANZ PCM or Trade Manager.

ACME Trading Ltd

ACME Imports Ltd ACME Exports Ltd ACME Freight Ltd
ACME Agn Exports ACME Auto Exports
Pty Ltd Pty Ltd
ACME Dairy Exports ACME Beef Exports ACME Forest Products

Pty Ltd Pty Ltd Pty Ltd



This section outlines general system tasks for ANZ Transactive. The following tips will assist you in your use of ANZ Transactive.

LOGGING IN

Each user accessing ANZ Transactive must have valid log on details. This may be requested via an application form, which
contains proof of identify and the form must be signed, dated and returned to the bank for processing (see Authentication).

Users with tokens will be required to enter in their User ID and Password together with their OTP (One Time Password) generated

by the token.

SESSION TIMEOUTS AND SAVING YOUR WORK

When using ANZ Transactive, your session will time out after 30 minutes of inactivity. A pop-up window will appear two minutes
prior to the session timing out unless a tab or a button has been selected. When your session times out:

> The system will save any work you have entered (at five minute intervals) on the transaction and reference data pages, provided
the entry meets the validation criteria

It is recommended that the User should save work periodically while working in ANZ Transactive.

2 https:Ihwww.tradeportal-trade... |- |§,

Your session will be timed out in 2
minutes unless you perform a system
action {(such as pressing a button in the
application or clicking a link to another

pagel.

&]p 2 @ mternst

If you have been timed out of your session, the system will advise the reasons as follows:

> ‘Because you have not performed any system actions (such as pressing a button or clicking a link to another page) for the last
30 minutes, you have been logged out.

Your information has automatically been saved. Please review it before continuing.’

LOGGING IN AFTER SESSION HAS TIMED OUT

If the system has timed you out after 30 minutes of inactivity, you can immediately log back into ANZ Transactive. Or, if you have
incorrectly logged out of the system by not selecting the Log Out button, you can attempt to log back into ANZ Transactive.

Upon logging in again immediately, you will be presented with a warning message to continue.

12



LOGGING OUT

When you've finished using ANZ Transactive, it is important to log out properly rather than simply closing the
application window.

If you close the window rather than log out, ANZ Transactive considers you to be still logged in.
Please ensure you click the ‘Log Out’ button to exit the session in a secure manner.

Log off the online session and turn off the computer when not in use.

ANZ ANZ Transactive

Messages Reports Reference Data - lanagement

Welcome, user's Name 7 sl Change my password Use ‘Log out’ button to exit
Summary rather than the X to close

Messages

You have 0 new mail messages awaiting attention. Create a mail message

You have 42 notifications from the bank.
Instruments

You have 33 pending transactions Create a transaction

Payment Transactions

You have 43 pending transactions

System Overview and Bank Support Information

A system overview is available to help you learn about the application. View support information

Helpful Hints

Do not use your browser's “Back”, "Forward”, or "Reload” / "Refresh" buttons to navigate in the system.
We recommend you set your screen resolution to 800 x 600 or higher.

Always use the "Logout” button, located at the top of most pages, to exit the system.

Be sure to let each page load fully before you begin entering information or performing actions.

Make sure you are using a supported Internet Explorer Version.

s en

Version 7.0.0.0.0082
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VIEWING YOUR USER PROFILE

WHAT IS A USER PROFILE?
Your ANZ Transactive User profile contains details stored about you in ANZ Transactive. In particular, it contains:

> Personal details, such as your name
> Security details, such as your Vasco Digipass / RSA Token ID from your security device

> Details of the security profile and threshold group that has assigned to you (see security profiles and Threshold groups)

HOW TO VIEW YOUR USER PROFILE
To view your User profile, complete the following steps:

STEP ACTION
1 If your ANZ Transactive Home page is not displayed, click the HOME navigation button to display it.
2 Click the View My User Profile button.
Your User profile appears.
3 When you've finished viewing your User profile, click the Close button.

ANZ Transactive

Reports Cas| nagement Subsidiary access

Welcome, user's Name 7 [l

Summary
View my user profile
Messages

You have O new mail messages awaiting attention. Create a mail message

You have 42 notifications from the bank.
Instruments

You have 33 pending transactions Create a transaction

Payment Transactions

You have 43 pending transactions

System Overview and Bank Support Information

A system overview is available to help you learn about the application. View support information

Helpful Hints

« Do not use your browser's "Back”, *Forward", or "Reload” / *Refresh” buttons to navigate in the system.
» We recommend you set your screen resolution to 800 x 600 or higher.

» Always use the "Logout” button, located at the top of most pages, to exit the system.

« Be sure to let each page load fully before you begin entering information or performing actions.

» Make sure you are using a supported Internet Explorer Version.

Version 7.0.0.0.0082

CHANGING YOUR USER PROFILE

This section explains how to change the password you use when accessing ANZ Transactive using a user id/password or an
RSA Token user only.

CHANGING YOUR PASSWORD

This section explains how to change the password you use when accessing ANZ Transactive using a user id/password or an
RSA Token user only.

> if you use a Vasco Digipass Token to access ANZ Transactive, please contact the ANZ Transactive Support Team to reset
your password.

14



HOW OFTEN WILL MY PASSWORD EXPIRE?

ANZ Transactive passwords expire every 90 days therefore you will be required to change your password at least once every
90 days. Expired passwords will inhibit access to the system and require a new password to be created via prompts at login.

Passwords used for accessing ANZ Transactive must follow these rules:

PASSWORD MUST PASSWORD MUST NOT

Contain at least 10 characters but no more than > Contain three consecutive characters that are the same

30 characters > Start or end with a space character

Contain both upper-and-lower letters Be the same as your User ID, First Name, Last Name, or Login ID, regardless of case
Contain at least one number (0..9) Be the same as any of your last 13 passwords

> Consist of repeating characters (i.e. aaaaaaaa)
> Consist of sequential numbers or letters

IMPORTANT DETAILS ABOUT PASSWORDS:
> Passwords are case-sensitive (for example, xyz0123abc is different to Xyz0123abc)

> Passwords expire every 90 days

> After three failed login attempts, you will be logged out and your password will be required to be reset by the company
administrator or bank administrator

> ANZ Transactive passwords should not be used for different websites, applications or services, particularly when they relate to
different entities.

> Users should not select the browser option for storing or retaining User names and passwords.

> If an incorrect password is entered more than 10 times, your account will be locked and will require unlocking by the bank.
HOW TO CHANGE YOUR PASSWORD
Follow these steps to change your password if you are a UID/Password or RSA Token user:

STEP ACTION
1 If your ANZ Transactive Home page is not displayed, click the HOME navigation button to display it

2 (Clickthe Change My Password button
The Change Your Password page is displayed

In the Current Password box, type your existing password

In the New Password box, type your new password

In the Retype New Password box, retype your new password again

(€)W BNV, I IR N B O}

Click on the Save & Close button

15



ANZ Transactive

leports Reference Data Cash Management

Welcome, Nicki Presley EIIIEEEN EEEITIIID
ange my passwor
_ g s = o

ANZ Transactive

Reports Reference Data

Change Your Password

To change your password, please enter your current password. Then create a new password that is easy for you to remember, complies with these constraints, and contains upp and f as well as numb
After doing so, press 'Continue’.

Current Password

New Password F_agﬂ New Password

FORGOTTEN YOUR PASSWORD?

If you have forgotten your password, contact your organisation’s ANZ Transactive administrator or bank administrator and request
your password to be reset. RSA Token and User ID/password Users can be changed by an organisation assigned administrator.

16



As an ANZ Transactive administrator you are able to complete a range of activities in relation to ANZ Transactive users within your
organisation. However, you cannot amend another user’s profile that has the same security profile as yourself.

This section covers the essentials functions performed by ANZ Transactive administrators.

TRANSLATIONS

Language content within ANZ Transactive can be customised to suit organisation Users. The following range of User languages

are available:

> Traditional Chinese

> Vietnamese

> Simplified Chinese

> Korean

> Japanese

The following categories of translated content are available:

> Labels

> Buttons

> Error messages

> Warning and information messages

ASSIGNING USER LANGUAGE
Simply follow the steps below to assign the language option for each of your users:

STEP ACTION

1 Logonto ANZ Transactive

2 Select the REFERENCE DATA tab

3 Select Users from the drop-down list.

‘N’
Filvi=
Messages

Reference Data

Please select the type of Reference Data to display from the drioocvn

Show:

Users

ANZ Transactive

Trade

[__logout ] Home

Cash Management

Reference Data

Click on the column headers below to sort the data in asmndmg or descending order (indicated by the red arrow).

it ame [secu rfie ——[rrshotdcrous

Presley

USER10
USER11
USER12
USER13
USER14
USER15
USER16
USER17
USER18

Mame
Marme
MName
Mame
Mame
Marme
Mame
Mame
Mame

Nicki

User's
user's
User's
User's
User's
User's
User's
Usre's
User's

Full Access
Administrator
Administrator
Initiate/Authorise
Initiate/Authorise
Initiate/Authorise
Initiate/Authorise
Full Access

Full Access

Full Access

Page 1 showing s 1-10 ) [ RURIEY
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STEP ACTION

4 Select the User profile that you want to change the language settings for from the list displayed

Go to the REGIONAL SETTINGS drop down box and select the language you wish to assign to the User

Click the SAVE & CLOSE button

N O o

Request the user to log into ANZ Transactive to now view the regional settings in the selected language

ANZ Transactive Home

Users > New User
bd Indicates Required Information

User ID *
I Save & close

First Name * Middle Initial Last Name *
Phone Number Fax Number
Email Address Region Setting *

Default Work View *

English (Australia)

I—SelectaWorkVIew-— - English (Canada)
Page Display Settin | English (Great Britain)
o e s | English (New Zealand)
For transaction pages: | English {United States)

& i = i d | French (Canada)
@ Display transactions in a single, scrolling page. | Indonesian(indonesia)

Recommended for users with fast Internet connections (g "a‘«ljapane i
" Display cti in a multiple-part page. | Korean )
Recommended for users with slower Internet connections (5 Simplified Chinese
| Traditional Chinese
| Wietnamese{Vietnam)

Screen Resolution:
& User's monitor has a Screen Resolution of B00x600 (Display standard listviews).
¢ User's monitor has a Screen Resolution of 1024x768 or higher (Display extended listviews).

UNICODE FUNCTIONALITY

Unicode functionality is available for specific input data fields required for Domestic Payments in some countries.
Please refer to the ANZ Transactive File Format Guides for further details and clarification on the Unicode fields available.

> Unicode functionality is not available for any other Payment functionality or Direct Debits apart from Domestic Payments.

> Unicode functionality is not available for payment amounts, dates and accounts.
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CREATE A USER ID / PASSWORD USER

Follow these steps to set up a new non-security device User.

BEFORE YOU BEGIN
Before you can add a User to ANZ Transactive, make sure you have:

> the personal details of the User that you want to create, and

> details of the ANZ Transactive security profile and threshold group required for the new User

If your organisation requires Users to be issued with Tokens to access ANZ Transactive, your company must complete an
application form with the required user details and authorised signatures and submit to ANZ for processing.

Note: All company authorisers and administrators require a security device to access ANZ Transactive.

CREATING A USERID / PASSWORD IN ANZ TRANSACTIVE
To create a User ID / password User complete the following steps:

STEP ACTION
1 Log on to ANZ Transactive, if you are not already logged in
2 Click the REFERENCE DATA navigation button
3 From the Show list, select Users
A list of your organisation’s Users appears
4 Click the Create a User button
The User page appears
5 Create a unique User ID for the User as per the below suggested naming conventions:

> Whole ID must be in uppercase
> Maximum 10 characters
>The ID must comprise of: Surname first (1st 6 letters only), then the initial of the user’s first name, followed by first three letters of

company ID, e.g. David Wong from ABC Book Shop would be WONGDAB C

6 Enter User information into the page by completing all mandatory fields
For information about what data is required in particular fields, click the @& button for assistance
7 In the Security section, ensure the radio button is selected for the user to enter a Login ID and Password for authentication
8 Enter the User's unique User ID as created in Step 5 into the Login ID field
This is the Login ID the user will use to access ANZ Transactive
9 Enter a temporary password into the New Password and Retype New Password fields
See Password Rules for creating and/or resetting a user’s password in ANZ Transactive
10 Select the user’s Security Profile which will determine the user’s rights within ANZ Transactive (see Security Profiles)
11 Select the account numbers and/or report categories for the user to have access to
12 Select the Save & Close button when completed
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PASSWORD RULES

The following password recommendations can be used when creating a password for a User ID/password.

PASSWORDS MUST PASSWORDS MUST NOT

Contain at least 10 characters but no more than Contain three consecutive characters that are the same

30 characters Start or end with a space character

Contain both upper- and lower-case letters Be the same as your User ID, First Name, Last Name, or Login 1D,

regardless of case

Contain at least one number (0...9) Be the same as any of your last 13 passwords

Consist of repeating characters (i.e. aaaaaaaa)
Consist of sequential numbers or letters

> Passwords are case sensitive (for example, xyz0123 is different to XyZ0123)

> Passwords will expire every 90 days

> After three failed login attempts, the user will be logged out and their password will be required to be reset by the
company administrator.

> After ten failed login attempts, the user will be locked out and their password will be required to be reset by the bank.
This count is cumulative and is not reset after you successfully log in. However, the count is reset when a password is changed

> ANZ Transactive passwords should not be used for different websites, applications or services, particularly when they relate to
different entities

> Users should not select the browser option for storing or retaining User names and passwords

RESETTING A USER’S PASSWORD

Follow these steps to reset a user password.

NOTE: This option is only available for users who access ANZ Transactive using User ID/Password or an RSA Token.

USER ID / PASSWORD USERS
To reset a User’s password, complete the following steps:

STEP ACTION

1

Log on to ANZ Transactive, if you are not already logged in

2 Clickthe REFERENCE DATA navigation button
3 From the Show list, select Users
A list of your organisation’s Users appears
4 Select the user from the list to reset their password
In the Security section of the User page, type the User’s new temporary password in the New Password and Retype New
Password boxes
Note: Passwords must comply with the password rules
6  Clickthe Save & Close button
The User's details are saved
7 Inform the User of their new temporary password. The User will be prompted to change their password the next time they log on
TOKEN USER

If your ANZ Transactive RSA Token access is suspended, please contact the ANZ Transactive support centre to have your
token reinstated.
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MAINTAINING USER DETAILS

DISPLAYING A USER’S ANZ TRANSACTIVE DETAILS
There are a number of procedures where the first step is to display the User’s details on the User page in ANZ Transactive.
To do this, complete the following steps:

STEP ACTION
1 Log on to ANZ Transactive

2 Clickthe REFERENCE DATA navigation button

3 From the Show list, select Users
A list of your organisation’s Users appears

4 Inthe User ID column, click the name of the User details you want to display
The User page appears

CHANGING A USER’S NAME, ADDRESS OR OTHER GENERAL DETAILS
To change a User’s name or other general details, complete the following steps:

STEP ACTION
1 Display the User's details
For instructions, see Displaying a User's ANZ Transactive details
2 Change the User’s details as required
For information about the data required in particular fields, click the @&l button for the relevant section of the page

3 When you have finished entering data, click the Save & Close button to save the User’s details

SUSPEND / RE-INSTATE USER ACCESS

Security device users, except for Vasco Digipass Token users, can be temporarily suspended from accessing ANZ Transactive.
Please contact the ANZ Transactive support Centre for assistance.

DELETING SECURITY DEVICE USERS

Please contact the ANZ Transactive Support Centre to delete / unassign Security Device Users from your organisation.

DELETING NON-SECURITY DEVICE USERS

Company administrators can delete a user profile that does not maintain a security device. To do this, complete the following steps:

STEP ACTION
1 Log into ANZ Transactive

Click on Reference Data navigation button

From the Show list, select Users

From the user profile page, select the Delete button

2
3
4 Select the User ID that is to be deleted
5
6

A message to confirm deletion will be presented. Select OK to complete the deletion process. User will now be deleted from
the list
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TYPES OF REFERENCE DATA

Reference data is information that is either:

> required by the system (e.g. security profiles, Users, threshold groups, panel groups and template groups)
> used to create transactions (e.g. templates, parties, phrases)

When registering for ANZ Transactive, your organisation will specify a number of default system settings that will govern the
organisation’s requirements. These settings provide the base set of reference data for the organisation.

Permissions to create and maintain reference data are usually provided to a small number of Users only.
For example:

> an administrator might manage system-related reference data such as security profiles, threshold groups, panel groups and Users

> afinancial controller might manage payment reference data such as templates and phrases

SECURITY PROFILES

A security profile is a group of system permissions that can be assigned to one or more ANZ Transactive Users.
The permissions assigned determine what each User can create, view, edit, authorise or delete within ANZ Transactive.

For example, some Users might be able to view transactions, while others can create and authorise them.

The security profile assigned to a User depends on their role within your organisation. It is your responsibility to:
> define appropriate security profiles for your organisation
> assign the correct profile to each User

Note: Any security profile changes to a user’s profile that requires or maintains a security device can impact the user’s ability to
perform their related functions within ANZ Transactive

ANZ TRANSACTIVE USER TYPES DESCRIPTION

Has the ability to create/edit/delete Users

Has the ability to create/edit/delete security profiles

Has the ability to create/edit/delete threshold groups

Has the ability to create/edit/delete work groups

Has the ability to view/create/edit/delete customised reports

Has the ability to authorise cash transactions

Has the ability to view/create/edit/delete customised reports
Has the ability to view and delete messages

Has the ability to create/edit/delete parties

Has the ability to create/edit/delete templates

Has the ability to create/edit payments

Has the ability to create/edit/delete messages

Has the ability to view/create/edit and delete customised reports
Has the ability to create/edit/delete parties

Has the ability to create/edit/delete templates

Administrator

Authoriser

Initiator

Has the ability to view/create/edit/delete customised reports
Has the ability to view and delete messages

VV| VVVVVIVVVVYV|VVYVVYV

Reporting

INITIATOR USERS
Users assigned with an Initiator security profile will automatically be assigned the ability to upload payment files by default.

THRESHOLD GROUPS
A threshold group defines authorisation limits for Users in relation to:

> the largest individual transactions they can authorise
> the combined maximum value of the transactions they can authorise each day

A threshold group can have different transaction and daily limits for each instrument and transaction type.

The threshold group assigned to a User depends on their role within your organisation. It is your responsibility to:
> define appropriate threshold groups for your organisation

> assign the correct threshold group to each User
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Note: The use of threshold groups is optional. It's important to understand that if a threshold group is not assigned, the user will
be able to authorise an unlimited value of transactions.

There is also the option of setting up panel authorities. To set up a panel authority you will need to complete an Application Form
and submit to the bank.

USERS
Each User has a unique User profile, which contains:

general information about the User, such as name and contact information

security access settings relating to passwords Tokens

details of the threshold group and security profiles assigned to the User

details of the template groups, account numbers and reporting categories assigned to the User

Confidential Payment Instruments/Templates settings. If the indicator is selected, the User will have access to confidential
payments and transaction templates created. The ability to initiate new payment transactions from templates that have been
selected as confidential will also be possible.

access to Live Market Rate indicator. If selected, the user will be able to provide live market rates for payment transactions upon
final authorisation.

PARTIES

A user can store commonly used Beneficiary party information in ANZ Transactive such as the party name, address, account
numbers, etc. After you create a party in the Reference Data tab, the party details can be retrieved from any transaction when the
Search for a Beneficiary button is selected. Once the required party has been selected from the list, the beneficiary details will
auto-populate into the transaction.

PHRASES

A user can store commonly used phrases that contains a standard text statement for insertion into a specific field within a
transaction. Examples of phrases include:

settlement instructions or standard goods descriptions

Note: Phrases can then be edited once selected within a transaction

TEMPLATE GROUPS

Provides the ability to assign templates to a group and to define which Users can use which groups. Enables further control over
the type of Instruments a User can create.

INSTRUMENT TEMPLATES

An instrument template is a predefined set of commonly used details within a single transaction. This allows the user to select a
template when creating a new transaction whereby most of the required fields have already been input. Minimum details will be
required to be entered or edited before Verifying the transaction.

An Instrument template can be assigned to a Template Group, and can have a Confidential Payment Indicator assigned, and can
also be a fixed template.

FIXED TEMPLATE
A fixed template is one in which the data fields can not be edited.

Is only available for Cash payments eg: BKT, BCHK, ACH/GIRO, CBFT, RTGS, CCHK.

FOREIGN EXCHANGE RATES

Foreign exchange rates are indicative rates required for transaction authorisation purposes. ANZ Transactive uses available rates to
convert transaction amounts to your organisation’s base currency in order to correctly calculate the user’s threshold limits.

In addition, ANZ Transactive has the capability to calculate the rates between two currencies that are not in your local base
currency, provided that the currencies are available in the Foreign Exchange Rate table and within the maximum threshold limit.
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MANAGING OF REFERENCE DATA

Follow these steps to manage your reference data. You can view and create reference data in ANZ Transactive. You can also edit
and delete reference data that was added by your organisation.

For further information, see the following section of the ANZ Transactive online help:
Using the System > Reference Data Procedures.

CREATING REFERENCE DATA
Note: You cannot edit or delete any reference data that was ‘Added by’ the bank

To create reference data, complete the following steps:
STEP ACTION

1 Log on to ANZ Transactive

2 Clickthe REFERENCE DATA navigation button

3 From the Show list, select the type of reference data you want to create, view, edit or delete
A table appears, listing the existing reference data items of the selected type

If your security profile allows you to create reference data, a Create button also appears. For example, if you selected Parties
from the Show list, the button is labelled Create a Party

4 (lick the Create a reference data item button
The relevant reference data creation page appears

5  Enter the details required for the reference data item into the page
For information on what data is required in particular fields, click the button for the relevant section of the page

6 When you have finished entering the details of the reference data, click the Save & Close button to save the reference data item

DISPLAYING A REFERENCE DATA ITEM
To display a particular reference data item, complete the following steps:

STEP ACTION
1 Log on to ANZ Transactive

2 (lickthe REFERENCE DATA navigation button

3 From the Show list, select the type of reference data item you want to view
A table appears, listing the existing reference data items of the selected type

4 Click the reference data item you want to view
The item you selected is displayed

CHANGING REFERENCE DATA
To change a reference data item, complete the following steps:

STEP ACTION
1 Display the reference data item you want to change
For instructions, see Displaying a reference data item

2 Change the reference data item as required
For information regarding data required in particular fields, click the button for the relevant section of the page
Note: You can only amend reference data that was added by your organisation

3 When you have finished changing the reference data item, click the Save & Close button
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DELETING REFERENCE DATA
NOTE: You cannot edit or delete any reference data that was ‘Added by’ the bank

To delete a reference data item, complete the following steps:

STEP ACTION

1 Display the reference data item you want to change
For instructions, see Displaying a reference data item

2 (Click the Delete button
A message appears asking you to confirm the deletion of the item

3 Click the OK button
The item is deleted
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This section contains details on ANZ Transactive payment transactions

PAYMENT TRANSACTION OVERVIEW

ANZ Transactive offers the following Payment product types:
> Direct Debits — an instruction to collect an amount directly from another account that is typically held by another account holder.

> Transfer Between Accounts - a transfer between a clients ANZ accounts within the same region associated with the
same organisation.

> Payments — made up of the following: Low value domestic funds transfer (ACH/GIRO), Book Transfer (BKT), Cross Border Funds
Transfer, (CBFT), Real Time Gross Settlement, (RTGS), Bank Cheque, (BCHK), Customer Cheque, (CCHK).

Note: Product offerings may differ across countries.
If the transaction is not authorised and sent to the bank, you can amend, delete or save it for later. You can also create a mail
message for this transaction ID. Each additional transaction you create also progresses through the transaction workflow.

The payment transaction area is accessed by clicking the Cash Management tab, then selecting Transactions tab.

TRANSACTION AND TRANSACTION ID STATUS

ANZ Transactive

Cash Management tab

show: 0L =]

Click the Link Below | [o g e or descending order (indicated by the red arrow).

Go To
8 s o ~Jrommcin s st Joo [amouns [smer o ttvalow sied [

™ eis3z718110 Payment lssus Started 22 Mar 2010 22 Mar 2010

™ 11637708110 Transfer Between Accounts. Issue ANZ Transactive Started 22 Mar 2010 22 Mar 2010

™ 11637728110 Transfer Between Accounts Issue ANZ Transactive CNY 100.00  Ready to Authorise test 22 Mar 2010 22 Mar 2010
Itemns 1 - 3 (3 Total)
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TRANSACTION STATUS

As a transaction progresses through the workflow as shown above, the transaction status will change.

The table below describes each possible transaction status.

STATUS DESCRIPTION TAB
Started The transaction has been created, but not verified Pending Transactions
Ready to Authorise The transaction’s data has been verified (see Verifying transactions) and the Pending Transactions

transaction is ready for authorisation

Authorise Pending

The transaction is in the process of being updated by the system

Pending Transactions,
Payment Transaction
History

Authorise Failed

Your organisation’s user access management criteria has not been met at
time of authorisation. eg. User attempting to authorise a payment over their
threshold limit.

When a User presses the Edit Data button to resolve an authorisation issue,
the status of the transaction will return to Started

Pending Transactions

Partially Authorised

Your organisation requires more than one User to authorise each transaction
Not all required Users have authorised the transaction

Pending Transactions

Future Value Dated
Authorised

Payment has been authorised with a future date

Future Value
Transactions

Authorised

The transaction has been authorised by all required authoriser(s)

Pending Transactions,

It is waiting for ANZ to process the transaction Payment Transaction
History

Processed by Bank ANZ has processed the transaction Payment Transaction
History

Cancelled by Bank ANZ has cancelled the transaction Payment Transaction
History

Deleted A User in your organisation deleted the transaction before it was forwarded to Payment Transaction
ANZ for processing History

Rejected by Bank

A transaction that has been returned to the organisation by the bank

Pending Transactions

Pending The transaction is currently at the bank awaiting processing Payment Transaction
History
Closed The transaction has been released from the bank Payment Transaction

File Upload Rejected

Payment file for upload has been rejected, awaiting deletion

Payment File Upload

Verified Pending FX

Payment is verified, awaiting foreign exchange rates to be entered

Payment File Upload

Verified

Payment is verified after editing an upload file

Payment File Upload

Verified - Awaiting
Approval

Payment is validated and awaiting approval or rejection of file

Payment File Upload

FX Threshold Exceeded

The payment amount has exceeded the maximum spot amount for FX
transactions. FX Deal is required to be booked and/or entered to continue.

Pending Transactions

Authorised-Pending
Market Rate

At time of authorisation, this status will appear if the ‘Request Market Rate’has
been selected on the payment. User is required to select'Request Ratebutton
to proceed.

Pending Transactions

CREATING PAYMENT TRANSACTIONS

WAYS OF CREATING TRANSACTIONS
Transactions can be created as follows:

> Creating and using a template
> Manually inputting data
> Uploading a payment file

27



CREATING TRANSACTIONS

CREATING A TRANSACTION MANUALLY
Follow these steps to create a transaction manually:

STEP ACTION
1 Click the Cash Management navigation button

2 Click the Transaction Type link in the left hand side panel.
The new transaction, Issue (Started) page appears as below with the transaction number assigned.

3 Enter payment details into the required fields.

4 Select Confidential Payment Indicator if the payment is confidential to ensure this is ONLY visible by other Users that have
been assigned the Confidential Payment Indicator.

5 Select Individual Debits indicator if the bulk payment requires a matching debit per credit entry created. Please contact your
bank to determine if this function is available in your country.

6 Select Request Market Rate checkbox if a live market rate is required upon final authorisation. Please contact your bank to
determine if this function is available in your country.

7 Once required fields have been input select Verify Data button to validate the details entered.
An error message will be presented to the user if issues are encountered therefore allowing the user to edit and re-verify the payment.

8 User(s) with authorisation rights can then authorise the payment from the payment screen or select authorise from the pending
transactions tab

9 User(s) without authorisation rights can select the close button to exit the screen.

Note: where countries mandate the requirement of company names to be included in local language, the alternate ordering
party name field will auto populate with the unicode characters if provided at time of registration.

ANZ Transactive

P31168803 Payment > Issue (Started)

Route transaction

Confidential Payment

Indicator
M Indicates Required Information

Transfer Between
Accoynts Template Payment Amount No. of Credits
Payments Click on the arrow to apply the selected template IC_Ll_r_ljarlc_y Amount

= Select Templats - -0 [ confidential Payment |AUD (W o
Beports

Execution Date * Foreign Exchange Rate Details

n No. F¥X Rat
6 ¥ [Feousy ¥ (2012 £ Contract Ho Ratp
[] Request Market Rate
Debit from Account X Rate Calc Method Equivalent Amount

Account Number and Associated Currency *  Ordering Party Name
Transaction 13551575-PNG Transactive FINET AUD 1 (AUD) (%6 Lrere: Request Market Rate

Type Link [individual Debits

%_s.t.!mgr Upload File Reference F_!h_-:_r.'!a_.h.! Ordering Party Name

Individual Debits

Indicator
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CREATING TRANSACTIONS USING TEMPLATES

To create a transaction using an existing template, complete the following steps:

STEP ACTION

1 Click the Cash Management navigation button

2 Click the Transaction Type link required
The new transaction page will appear

3 Select the existing template from the drop down list provided, then click the arrow button to load

Note: Any Users assigned to Template Groups will only have access to assigned templates.

4 If additional details are required for the payment, complete as per required. If working with a fixed template no content will be
editable, and no additional details can be added.

Once complete,
> select Save or Save & Close if you wish to continue working with the transaction at a later time
> select verify data to validate the payment details

> payment is ready to be authorised

CREATING TRANSACTIONS USING A PAYMENT FILE

WHAT IS A PAYMENT FILE?
A payment file is a configured file format containing one or more payees (e.g. Payroll).

PAYMENT FILE UPLOAD
To upload a payment file, complete the following steps:

STEP ACTION

1 Click the TRANSACTION navigation button

2 Click the Payment File Upload tab

3 Click the Browse and search the pipe delimited file or fixed length file for upload

4 Select the file for upload and double click the file

5 Select the File Upload button

6 Click the Refresh button to check progress of the file upload status
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ANZ Transactive

Browse to the location of your payment file and select the "Upload File' button.

Payment File Location

[ srowse...g| m Browse button W Upload file button

show: [T ]

sort the data in ascendi icated by the red arrow).

Validation Status|Transaction Status|Transaction 1D

Itams O - 0 (0 Total)

VALIDATION STATUS

When a payment file has been uploaded, ANZ Transactive will commence a series of format validations on the file.

VALIDATION STATUS OCCURRENCE

SOLUTIONS

File Validation Pending File has been uploaded to the server after the

following validation:
> File Format
> Payment Method
> Debit Account

Nil action required. System will commence second
stage of the validation process

Validation in Progress Verification validations will be performed behind

the scenes:
> Beneficiary Level

Nil action required. System will produce a
validation status at the end of the process of:

> Validation Successful
> Validated with Errors —or-
> Validation Failed

Validation Successful All beneficiary parties have passed validation
process. i.e. All 50 beneficiaries loaded in the file

are deemed successful

> Ready to Authorise —or-
Refer to Authorising a payment file on page 41
> Verified-Pending FX

Refer to Transaction Status table on page 30 see
row Verified — Pending FX

Validated with Errors Portion of the beneficiary validations fail but not all.

i.e. two beneficiaries have failed out of 50 parties
loaded

Confirm the acceptance of the successfully passed
beneficiaries and continue to process the balance
of the file

OR - Reject entire file, repair the file where the
errors occurred and re-upload again

Validation Failed All beneficiaries have failed the validation process.

i.e. all 50 beneficiaries loaded in the file have failed

User to repair the pipe delimited file and re-upload
again

File Confirmed When user has Confirmed the acceptance of the
successfully passed beneficiaries the validation

status will be updated to File Confirmed

> Ready to Authorise —or-
Refer to Authorising a payment file on page 41
> Verified-Pending FX

Refer to Transaction Status table on page 30 see
row Verified — Pending FX

File Rejected When user has Rejected the entire file, the

validation status will be updated to File Rejected

User to repair the pipe delimited file and re-upload
again

FILE FORMAT SPECIFICATIONS

For file format specifications, please refer to the ANZ Transactive File Format Guides.
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VERIFY FX BUTTON

If the transaction status is ‘Verified - Pending FX' - refer to ‘Transaction Status’ table on page 27 you can open the payment via
the Transaction ID and enter the exchange rate details, or select the Request Market Rate checkbox if a live market rate is to be
requested upon final authorisation. All other fields will be uneditable upon selecting the Verify FX button. The transaction will
then appear as ‘Ready to Authorise’.

UPLOAD LOG SCREEN

Once the validation has been completed on the payment upload file, a new link will be visible in the upload log column.

ANZ Transactive

T 00Feb 2030 ORMBAM  Mempla-ACH § and 3 wil taaict akiaton Faied o e @
I 02 res 3011 on:tam
I 03 Feb 2081 121500

The description of the link and content in the log will be determined by the success, partial success or failure of the uploaded file.

In the event the uploaded file has been successful, the link will be displayed as ‘View Log’. Once the View Log link has been
selected, a log displaying the following information pertaining to the file will be displayed:

> User Name (User whom uploaded the file)

> Payment File Name (can be displayed in Unicode characters)

> Validation Status (See also Validation Status)

> Validation Processing Complete Time (Date and time the uploaded file was completed)

> Payment File Amount (Containing the total amount of all the beneficiaries in that file, inclusive of any parties that return errors)

Once the log has been viewed (not essential for successful payments), the user can select the Close button to exit out of the
upload log screen.

ANZ Transactive

™ 00 Feb 2001 DUMBAN  mample-ATH § #nd 3wl ixt
I 00 Fet 3001 coctman
[ o3 res 2081 32500

In the event the uploaded file has been partially successful, the link will be displayed as ‘View Errors’. Once the View Errors link has
been selected, a log displaying the information pertaining to the file and the failed beneficiaries will be displayed as follows:
> User Name (User whom uploaded the file)
> Validation Status (See also Validation Status)
> Validation Processing Complete Time (Date and time the uploaded file was completed)
> Number of Beneficiaries Uploaded (total of Beneficiaries originally loaded in the file)
> Number of Beneficiaries that Failed (number of Beneficiaries that did not pass validation)
> Beneficiary Listview
> Beneficiary Name
> Payment Amount
> Customer Reference
> Error Message (relating to that beneficiary)
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ANZ Transactive

code vake ‘22" is invald for: Charge contact echnical support
- ‘Charges * i reduired.
- The code value 22" i invald fer: pe Type'. Pl
Bancficiary tstnod, B, 43¢ T (e ueie nabe BEL

Baneficiay sk no6, 8, 454 Tuuug_-:u'zzam fer: "Bask Charge Type'. Please contact lechnical tuppart.

Dependent on the errors displayed in the Error Message field, there is the option to either: 1. Confirm the file, by accepting the
number of successful beneficiaries and opting to omit the failed parties, OR

2. Reject the entire file and re-upload a corrected file.
Refer to Function Buttons below

Once the file has either been confirmed or rejected, Close the log window to return to the Payment Upload File tab.

FUNCTION BUTTONS

New function buttons have been added to the payment upload process. This is a result of the updated upload feature whereby a
user can confirm, reject, verify the FX formatting or deleting a file from the list view, uploaded payment screen or log pages. The
buttons are described below:

CONFIRM BUTTON
A function button will be displayed in the View Errors window.

If the Confirm button has been selected, the Validation status will change to File Confirmed with the User Name displaying the
user whom confirmed the file.

The transaction status will appear as Ready to Authorise, OR as Verified - Pending FX

REJECT BUTTON
A function button will be displayed in the View Errors window.

If the Reject button has been selected, the Validation status will change to File Rejected with the User Name displaying the user
whom rejected the file.

The transaction status will appear as File Upload Rejected.

VERIFY FXBUTTON
A function button will be displayed in the payment screen.

If the transaction status appears as Verified — Pending FX, the user can open the payment via the Transaction ID and enter in the
exchange rate details, or select the Request Market Rate checkbox if a live market rate is to be requested upon final authorisation.
All other fields will be uneditable; therefore the Edit button will not be available in this screen, for this status. Upon selecting the
Verify FX button.

The transaction status will appear as Ready to Authorise.

DELETE REJECTED ITEMS BUTTON

Only upload files with a transaction status of File Upload Rejected can be deleted from this list view. The user will select the
checkbox against the files that are to be deleted and then select the Delete Rejected Items button. Once removed, the failed file
will only be visible from the Transaction History tab, while the Upload Log details for this file will only be available via reporting.

DELETING TRANSACTIONS FROM THE PAYMENT FILE UPLOAD TAB

Only transactions with a transaction status of ‘File Upload Rejected’ may be deleted from this tab. An error message “only transactions
with a transaction status of File Upload Rejected maybe deleted from this tab’ will be displayed in the event a file that doesn’t
meet this status is attempted to be deleted.
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DELETE TRANSACTIONS FROM THE PAYMENT FILE UPLOAD TAB

Only transactions with a transaction status of ‘file upload rejected’ may be deleted from this tab. An error message “only
transactions with a transaction status of file upload rejected maybe deleted from this tab’ will be displayed in the event a file
that doesn’t meet this status is attempted to be deleted.

For payments at a ‘Started’ or ‘Verified’ status that are required to be deleted, must be verified to a ‘Ready to Release’ status first.
The user can then delete the transaction from the Pending Transactions tab.

ANZ Transactive

Future Value Transactions

These transactions are all suthorised and have future value payment dates. They remain here until the future date and only then are they tranamitted to the bank.

LTI My Work =

100.00 22 Apr 2010 22 Mar 2010 22 Mar 2010
Iterns 1 - 1 (1 Total) Page 1

BENEFICIARY LIST VIEW
A total of 50 beneficiaries of an uploaded payment file are able to be viewed per a scrollable screen or via multiple pages.
This field allows you to customise a search for a beneficiary using the following criteria:

> Payment status

> Beneficiary name

> Beneficiary bank name

> Amount

The search results are dependent on the criteria you enter within the beneficiary list view. The returned results will default in
order by the most current date.

Where no results are found based on the search criteria entered, the list view will display a ‘no rows found’ message.

You can select the relative radio button to view and/or edit the beneficiary details within the payment depending on the status
of your multiple and/or file upload payment transaction.
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CREATING TRANSACTIONS REQUESTING LIVE MARKET RATE

To create transactions using live market rates, complete the following steps:

STEP ACTION

1

Click on the Cash Management navigation button

2 Click the Transaction Type link in the left hand side panel
3 Enter payment details as per normal
Upon selecting the debit account, the Request Market Rate checkbox will appear in the Foreign Exchange rate Detail section
Select the checkbox to request a live rate upon final authorisation
4 Once required fields have been input, select Verify Data button to validate the details entered
Note: The carded rate calculation method will be displayed until the market rate has been requested and accepted
5 User with authorisation rights can then authorise the payment from the Payment Screen or the Pending Transactions tab.
6 Once the transaction has been final authorised, a warning will be displayed to the user as :
Market Rate or a Foreign Exchange Contract is required to successfully authorise the transaction.
All required authorisers must authorise the payment first before the Request Rate button will appear to the user with
Live Market Rate access.
7 Click on the Request Rate button to send a request to the bank for a live market rate
A window will appear to confirm that the request has been sent to the bank
FX Online Market Rate
Requesting FX Rate....pl wait a t
8  The FXrate quote will be displayed on- screen

Either click on the Accept Rate or Reject Rate button

FX Online Market Rate Close

Please select the “"Accept FX Rate” button to confirm the FX
Quote:

FX Rate Quote: 6.33840

Payment Amount: 10000000 CNY
Equivalent Amount: 15776.85 USD
Time Out: 19 Seconds

The user will have 20 seconds to select their option. The session will time out after this period and the quote will no longer
be available

If the session has timed out, the error message will be displayed:

‘Foreign Exchange Quote has timed out. Please try requesting a quote again or enter the details of your Foreign Exchange
Contract and select “authorise”to complete the transaction or contact the bank for assistance!

If’Accept Rate’ was selected, the following screen is displayed while the rate is being confirmed

FX Online Markel Rate

Confirming FX Rate Deal....pl wait a

If the rate has been successfully booked the payment screen will close and the payment will be sent to the bank for processing.
The status of 'Foreign Exchange Deal has been successfully booked” will appear on the Pending Transactions page above the
usual transaction status message.

If ‘Reject Rate’ was selected, the rate will be cancelled and the user can either re-request a live market rate or manually input a
booked Foreign Exchange contract.
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FUTURE DATED PAYMENTS

CREATING A FUTURE DATED PAYMENT

Payments excluding: Transfers Between Accounts, International Payments (Cash or Trade) and Direct Debits can be future dated
and authorised. An authorised future dated payment will be held in the Future Value Transactions tab awaiting the execution
date. Users will be able to edit or update the payment and re-authorise or delete the payment prior to the execution date.

A payment that contains two currencies that are not the base currency or a payment that requires a booked rate can not be saved
or authorised as a future value dated transaction if a forward exchange contract (FEC) rate has not been entered.

FUTURE VALUE DATED TRANSACTIONS

ANZ ANZ Transactive

Messages Reports Reference Data Cash Management Subsidiary access

Account Balances Transactions

Below are listed your corporation's pending, authorized and paid transactions.

Future Value Transactions

Payment File Upload ] Pending Transactions Authorised Transactions ] Payment Transaction History ]

These transactions are all authorised and have future value payment dates. They remain here until the future date and only then are they transmitted to the bank.
Show: Rerech s pae

Click the Link Below

Click on the column headers below to sort the data in ascending or descending arder (indicated by the red arrow).

To Go To ...
® Finvesion 12 msesion oslrmsemionlomss o Jamasns Jonmas s ot s [ st [

Account Balances

O P1667318110 Payment Issue Multiple Beneficiaries ~ CNY  1,815.00 22 Apr 2010 Multiple References 21 Apr 2010 21 Apr 2010
orireere: Babwer. O p1667328110 Bovmact o Multiple Beneficiaries ~ CNY  1,815.00 20 Apr2010  Multiple References 21 Apr2010 21 Apr 2010
[ P1684488110 Payment Issue Multiple Beneficiaries  CNY 3.00  01Jun2011  Multiple References 25 Mar 2011 28 Mar 2011

Payments
[0 p1684708110 Payment Issue Multiple Beneficiaries CNY 3.00 06 Jun 2011 Multiple References 25 Mar 2011 28 Mar 2011

Reports Items 1 - 4 (4 Total)

L Delete selected item(s) Route selected item(s)

VIEWING FUTURE DATED TRANSACTIONS
If the transaction ID from the list view is selected the payment screen will be presented. The following options will be available:

Edit, Route Transactions or Close.

EDITING A FUTURE DATED PAYMENT
If the ‘Edit’ option is selected the user will be presented with the following payment processing buttons:

Attach a Document, Save, Save and Close, Route Transaction, Verify Data and Close.

A payment that contains two currencies that are not the base currency or a payment that requires a booked rate can not be saved
or authorised as a future value dated transaction if a forward exchange contract (FEC) rate has not been entered.

FUTURE DATED PAYMENT INVOLVING FX

Future dated payment involving FX requires an FX contract to be booked with the bank. A valid FX Contract No. and FX Rate must
be entered into the Foreign Exchange Rate Details fields before the payment can be authorised.

AUTHORISATION PROCESS ON EXECUTION DATE

Upon the execution date ANZ Transactive will run through the following series of new authorisation checks before it sends the
payment to the bank:

> Ensure that all the users that authorised the transaction are still valid users
> Use current FX rates to determine and perform the Daily Limit Exceeded calculation
> Change the transaction status to Authorised

> Send the completed authorised transaction to the bank
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BENEFICIARY EMAIL NOTIFICATION OVERVIEW

This section provides details on the ANZ Transactive beneficiary email facility. For further details please refer to the ANZ
Transactive Online Help.

The end beneficiary of the payment can be notified via email upon successful processing of the Portal payment by the bank.

EMAIL ADDRESS REQUIREMENTS

Where an email is required to be sent to the beneficiary, enter the beneficiary email address in the Beneficiary Email Address field
on payment activities only. Multiple addresses can be input into this field and separated by commas (no spaces) up to maximum
character limit of 255.

EMAIL TRIGGER RESPONSE
The email notification to the beneficiary will be triggered upon two scenarios;

GPP countries will send an email communication to the beneficiary if an email address is present on the payment transaction when
the payment status is completed.

Non GPP countries will send an email communication to the beneficiary if an email address is present on the payment transaction
when the payment status is Processed by Bank.

EMAIL CONTENT

The beneficiary will receive an email from ANZ with the Portal payment reference number in the subject title. The body of the
email will contain the message of an attached payment credit advice, to which the beneficiary can then inturn contact the
ordering party for any queries.

An attachment embedded in the email will contain the entire payment details, inclusive of any invoice details but will omit the
complete beneficiary account number by only stating the last 4 digits.

EMAIL VALIDATION

Email addresses entered in the Beneficiary Email field will not be validated, nor will a notification be sent via the Portal notification
tab or email notification feature if the communication has not reached the beneficiary party.

Note: The bank will obtain a report advising the failed beneficiary communication attempts in order to advise of the unsuccessful
mail.

An example of the Email communication is shown below.

‘ﬂ'\hhﬂ_ﬂ““ﬂulﬂ: - 8%

2 Bsmacer = @ Pemen | ) Thsws g 0[]0 @ e - @ O @b

ﬂ“-‘ L4 EMAIL MESSAGE s cosed 1t
This bs @ computer generated advice, Please do not reply to the sending address. (Hard coded tex)
BANK GROUP Sender Name

To: Beneficlary Name

Subject: <'payment_system_ref” from DomesticPayment class for the specific

Beneficlary only. If ‘payment_system_ref' is blank, insert
"sequence_number” from DomesticPayment class (aka - Beneficlary

Sequence ID)>
On behalf of: Ordering Party Name: m
W have paid: Beneficlary Name
WVia: Payment Method (Description)
On account: Bene account number last 4 digits preceded by 2223
A Beneficlary Bank | Branch Code

Beneficiary Bank Name
Processing Date: Value Date Amounk: 000.00
Our reference: Instrument number Payment Currency: X000
Payment Detalls:
Detalls of Payment from the Payment transaction.

: ’ Invoice Datails:

Thix e-mail and any attachments to it {the "Communication”) is, unless otherwise stated, conflidential, may
contain copyright matertal and t for the use only of the intended reciphent. If you recetve the

Communication In ermor, plsase notify the sender immediately by retum e-mail, daiete the Communication
and the return e-mall, and do not read, copy, relranemit of othervise deal with It, Ay views sxpressed in
nuﬂumn*m;mdm o thea incinidial condir anh. unkice st chatad Bo b thace of el
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CREATING DIRECT DEBITS

A direct debit is an instruction that the bank account holder gives to his or her bank to collect an amount directly from another
account that is typically held by another account holder.

You have the option of uploading a direct debit file or manually processing a single entry transaction.

STEP ACTION

1 Click the RECEIVABLES MANAGEMENT navigation button.

2 On the Direct Debits table click the CREATE A TRANSACTION button.
The New Transaction, direct debit transaction page will appear

3 Follow the on-screen instructions.
For information about how to complete the page, click the & button.

This instruction is then printed by the bank and sent to the debit party for payment.
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EDITING PENDING TRANSACTIONS

WHAT IS A PENDING TRANSACTION?

A pending transaction is one that has been started, in progress and/or is awaiting authorisation to be sent to the bank.
You can access pending transactions from the PENDING TRANSACTIONS tab or the Transaction History tab of the Cash
Management button.

If a transaction has been authorised and no longer visible on the pending transactions tab, you will be unable to edit
the transaction.

Note: If the payment has been processed by bank the transaction cannot be stopped or edited.

EDITING A PENDING MANUAL TRANSACTION
Follow these steps to edit a pending transaction:

STEP ACTION

1 View the transaction
For instructions, see Viewing transactions

2 What is the status of the transaction
Started: The transaction is ready to edit; go to step 3
Ready to Authorise, Partially Authorised, or Authorise Failed: Click the Edit Data button. The transaction redisplays in edit mode
For information on authorisation failures, see Viewing authorisation errors

3 Edit the transaction as required

4 When you have finished editing the transaction, click save and close or verify button.

For information about which button to click, see the following topic in the ANZ Transactive System online help: Using the System
> Instrument Procedures > Working with instruments > Working with Instruments and Transactions > Transaction and Template
Action Buttons

EDITING A PENDING UPLOADED FILE

When the edit button within the payment screen is selected ANZ Transactive will determine if the payment was either uploaded
using a file format, or if the payment details were manually entered.

If the payment was uploaded via a file, the following fields will be editable:
Execution date

FX Contract Number

FX Rate

Request Market Rate checkbox

Delete a Beneficiary

Once the details have been added, amended or deleted, then simply select either the Verify or Verify FX button to continue
the process.

WHAT'S NEXT?

After a transaction is edited the data must be verified before it can be authorised. This is the case even if the transaction was
previously verified before it was edited.
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ROUTING TRANSACTIONS

To facilitate the processing of transactions with your organisation and related organisations (see Organisation subsidiaries), you
can route a transaction to:

> A particular User
> A particular organisation’s default User
For example, when a transaction is ready for authorisation, you could route it to an authoriser.

This topic describes how to route transactions individually and in groups.

ROUTING A SINGLE TRANSACTION WITHIN THE PAYMENT SCREEN
Follow these steps to route an individual transaction:

STEP ACTION
1 View the transaction
For instructions, see Viewing transactions

2 Click the Route Transaction button
The Route Item(s) page appears

3 Select the user or organisation you want to route the transaction to
For information about what data is required in particular fields, click the button for the relevant section of the page
4 Click the Route Item(s) button
The Transactions area appears, with a message at the top advising you that the transaction has been routed successfully

ROUTING MULTIPLE TRANSACTIONS FROM THE PENDING TRANSACTION TAB
Follow these steps to route one or more transactions at the same time:

STEP ACTION
1 Click the CASH MANAGEMENT navigation button

2 Click the TRANSACTIONS tab
The Pending Transactions page appears (default tab)

Select the check box of each transaction you want to route

4 Click the ROUTE SELECTED ITEM(S) button
The Route Item(s) page appears

5 Select the User or organisation you want to route the transaction(s) to view

6 Click the ROUTE ITEM(S) button

The Transaction area appears, with a message at the top telling you that the transaction(s) have been
routed successfully
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DELETING PENDING TRANSACTIONS

WHEN CAN TRANSACTIONS BE DELETED?
You can only delete pending transactions (those that have a status of Started, Ready to Authorise or Partially Authorised).

After a transaction has been authorised, you cannot delete it.

Whether ANZ can cancel a transaction depends on the current state of the transaction’s processing. For example,
ANZ cannot cancel a transaction that it has already processed and transmitted.

DELETING PENDING TRANSACTIONS
Follow these steps to delete transactions:

STEP ACTION
1 Click the CASH MANAGEMENT navigation button

2 Clickthe TRANSACTIONS tab
The Pending Transactions page appears (default tab)

Select the check box of each transaction you want to delete

4 (lickthe DELETE SELECTED ITEM(S) button
A message appears, asking you to confirm the deletion of the transactions

5 Click the OK button

The Pending Transactions page redisplays. For each item you deleted, a message appears at the top of the page to inform you
whether the deletion was successful

VERIFYING TRANSACTIONS

After you have created a transaction, its data must be verified before it can be authorised. This topic explains what transaction
verification is and how to complete this action.

WHAT IS VERIFICATION?
Verification is the second stage of the transaction workflow.

When you verify a transaction, the system:
> Checks the transaction against a list of standard data requirements for the transaction
> Changes the transaction’s status from ‘Started’ to ‘Ready to Authorise’if the verification checks are successful

If the verification is unsuccessful, the system displays an appropriate error message for each verification error.

BEFORE YOU BEGIN
You can only verify a transaction if:
> Your security profile includes create/modify permission for the transaction type that you want to verify

> The transaction has a status of Started

VERIFYING A TRANSACTION
Follow these steps to verify a transaction:

STEP ACTION
1 View the transaction
For instructions, see Viewing transactions
2 Clickthe VERIFY DATA button

The system performs the verification checks, then displays a message at the top of the page to inform you whether the
verification was successful

3 Was the verification successful?
Yes: The transaction is now ready for you to authorise it (see Authorising transactions)
No: Resolve all errors, then go to step 2
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VIEWING AN AUTHORISED TRANSACTION

Follow these steps to view an authorised transaction:

STEP ACTION
1 Click the CASH MANAGEMENT button
2 Click the TRANSACTIONS tab
Select the Authorised Transactions tab
The Authorised Transactions page appears

3 In the Transaction column, click the transaction that you want to view
The details of the transaction appear

4 When you've finished viewing the transaction, click the Close button
The Authorised Transactions page redisplays

Note: Once the bank has processed the transaction, the payment will move form the Authorised Transaction tab to the
Transaction History tab.

VIEWING AUTHORISATION ERRORS

ANZ Transactive

@ No Foreign Exchange Rate has been defined for currency of this transaction. Please define an FX rate for this currercy.

D1194158100 Domestic Payment > Issue (Started)

You can only view information on an authorisation error at time of authorising as per above. Transactions will remain in pending
transactions queue pending editing, or deletion.

MULTIPLE AUTHORISATIONS

For some transactions your organisation might require more than one user to authorise. This will be dependant on the authorisation
mandate/signatories required by your company.
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AUTHORISING MULTIPLE TRANSACTIONS AFTER VIEWING THEM
Follow these steps to authorise multiple transactions at the same time after viewing them:

STEP  ACTION
1 Click the CASH MANAGEMENT navigation button
2 Click the TRANSACTIONS tab
The Pending Transactions page appears (default tab)
Select the check box of each transaction you want to authorise
4 Click the Authorise Selected Item(s) button

If the authorisation was successful, the transaction is:
> changed to a status of Authorised or Partially Authorised
> listed on the Pending Transactions page if its status is Partially Authorised, or
> listed on the Authorised Transactions page if its status is Authorised (see Viewing an authorised transaction)
> sent to ANZ for processing
If the authorisation was unsuccessful the transaction:

> remains on the Pending Transactions page
> have an Authorise Failed in the Status column (see Viewing Authorisation Errors)

AUTHORISING A BULK PAYMENT FILE
When the transaction status appears as ‘Ready to Authorise’, a file can be authorised by either of the following two options:

1. Select the transaction ID from the Payment File Upload tab to open the transaction. The authoriser can then select the
‘Authorise’ button to proceed with the authorisation process.

2. Select the Pending Transactions tab. The authoriser can then select the checkbox against the transaction and select the
‘Authorise’ button to proceed with the authorisation process.

Once the transaction has been successfully authorised, the payment will be displayed in either the Authorised Transactions
tab, or the Future Value Transactions tab, if the execution date is future dated.
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WHAT IS A MAIL MESSAGE (TRACER) FOR EXISTING TRANSACTION?

As described in the creating and sending messages section, ANZ Transactive allows you to create mail messages.
This function can be used to trace an existing transaction.

For example, if payee is claiming non-receipt of funds on a particular date, you can use a mail message (Tracer) transaction to ask
ANZ to follow up the payment.

CREATING A MAIL MESSAGE (TRACER) FOR EXISTING TRANSACTION

To create a tracer from an existing transaction, select the Transaction ID from the Cash Management > Transactions > Payment
Transaction History tab. Select the Create a Mail Message button (see Creating and sending messages).

VIEWING TRANSACTIONS

Follow these steps to view a transaction:

STEP ACTION
1 Click the CASH MANAGEMENT navigation button
2 Click the TRANSACTIONS tab to view the transaction
Select the tab that contains the transaction you want to view
If you want to filter the list of transactions that meet certain criteria, select the required option from the Show or Display list

4 In the Transaction ID or Transaction column, click the transaction that you want to view
The transaction’s details appear

5 To view the advice click on the advice link or PDF link.

TRANSACTION HISTORY LOG

This function enables all users with Cash Payment products assigned, to view the history of the cash payment transaction.

The transaction history log is displayed in the payment summary screen under the Transaction Log tab this will be available for
the following cash payment products:

> Transfer between Accounts
> Payments

> International Payments

Transacliun Log

in ascending or ending order (indicated by t

09 Mar 2010 12:00PM  Create CNPROJECT1 / China Child Project Team (English) Started

09 Mar 2010 12:00PM  Verify CNPROJECT1 / China Child Project Team (English) Ready to Authorise

09 Mar 2010 12:00PM  Authorise CNPROJECT1 / China Child Project Team (English) Authorised-Pending Market Rate
17 Mar 2010 12:00PM  Confirm Fx Deal  CNPROJECT1 / China Child Project Team (English) Authorised

Each time the user selects the ‘Save’ or ‘Save and Close’ or ‘Verify’ or ‘Authorise’ button, the system will capture the entry in the
transaction history log in a listview as described below:

COLUMN HEADING  DESCRIPTION

Date & Time Date and time of when the action was performed

Action The type of action that was performed by the user, e.g. Create, Save, Verify, Authorise, Bank*, etc.

User User ID, first & last name of the user whom performed the action

Panel Level Panel level of the user authorising the transaction. This field will only be updated when the user authorises the
transaction. The values in this field will be either A, B or C

Status The status of the transition as at Save or Save and Close, e.g. Started, Ready to Authorise, Partially Authorised,

Authorised, Authorised Failed, Rejected by Bank, Cancelled by Bank, Processed by Bank.

*Where the action status appears as Bank, this function was performed at ANZ and will display a status e.g. Processed by bank,
Rejected by Bank, etc. 43



WHAT IS A TRADE INSTRUMENT

A trade instrument is a group of transactions in ANZ Transactive relating to a particular business deal.

The first transaction for an instrument is either an:

> Issue transaction that a user in your organisation creates using ANZ Transactive for example, Issue Import Letter of Credit
or Guarantee

> Advise or issue transaction created by ANZ for example, Advising an incoming Export Letter of Credit.
Subsequent transactions include:

> Amendments

> Tracers

> Payments (issued by ANZ)

> Usance’s (issued by ANZ).

An instrument can also have related instruments. For example, a term Letter of Credit would have related instruments
representing future payments.
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TRADE

To work with Trade instruments click the Trade navigation button.
To learn more about Trade, click ANZ Transactive online help.

ANZ Transactive
Clickthe ? button and the Help

screen will appear as shown:

Show: Work for ACME v

oispioy: [N Tronsoctions

I~ LMP26118110 Import LC Amend A Jome > Using the Sy i O
I LMP26118110 Online Help Help Home

Instruments Overviewv -

The (nslumenis area is where you view, create, and process frade Lepsacions, 'Mlonywmh s bution on i

bar, the area displays, the Purchase Ordars, Pendng 'E,Aumonm‘lransac'm.ﬂIrsrrunranlsbr_\t

Each displays a listing pag .uwmmbmmwmammmmnumwm

We cycle. You can clck on any or e Pending or History tabs

view the page for

As shown In s fgure, y ew trade for a variety of types, by copying from and exdsting instrument or

mum wmmammmmm

I you do not have minimum seculy ghis toinstruments. you will not be able fo access the Instruments area.

Foreach type. one or more tri P the type(s) ¥ creale

type.

Impart Letier of Credt
Quigoing Standby Leter of Credit x X X
Ik Export Lefier of Credt (ransfer) X X X :-I
[T 1S [ tntemes %

TYPES OF TRADE INSTRUMENTS
ANZ Transactive supports the following types of trade instruments:
> Import Letter of Credit
> Export Letter of Credit - Transfer, advising and assignment of proceeds.
> Standby Letter of Credit
> Guarantee

> Trade Loan Request

The types of instruments that you can work with in ANZ Transactive are determined by:
> The instruments that your organisation selected to use when registering for ANZ Transactive

> The permissions in your security profile.
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WHAT IS A TRANSACTION?

A transaction is an activity related to a Trade instrument. ANZ Transactive allows users to create the following types of transactions:
> Issue: the initial transaction that advises ANZ of a new instrument (this includes the assignment of an Export Letter of Credit)
> Amend: a transaction that advises ANZ of changes to an instrument (this includes the transfer of an Export Letter of Credit)

> Tracer: a request to ANZ via Portal mail message to trace a transaction.

TRANSACTION WORKFLOW
All ANZ Transactive transactions go through the common workflow process shown in the following diagram.

Authorise Bank

Create Verify : C
Transaction Processing

Transaction Transaction

Verification Errors Failed Authorisation

Notification

TRANSACTION AND INSTRUMENT STATUSES

As a transaction progresses through the workflow shown in the previous section, its status changes to reflect where the
transaction is in the workflow.

The transaction status is shown in the following Trade tabs:
> Pending Transactions, Authorised Transactions, and Instrument History

> the Instrument Summary page.

An instrument is ‘Pending’ until ANZ processes the transaction, once completed the status will change to ‘Active’.

The table below describes each possible transaction status.

STATUS DESCRIPTION PAGE IN SYSTEM

Started The transaction has been created, but not verified. Pending Transactions,
Instrument History

Ready to Authorise The transaction’s data has been verified and the transaction is ready for Pending Transactions,

authorisation.

Instrument History

Authorise Pending

The transaction is in the process of being updated by the system.

Pending Transactions,
Instrument History

Authorise Failed

Your organisation’s user access management criteria has not been met at
time of authorisation. eg. User attempting to authorise a payment over their
threshold limit.

Pending Transactions,
Instrument History

Partially Authorised

Your organisation requires two users to authorise each transaction, but only one
user has authorised the transaction.

Pending Transactions,
Instrument History

Authorised The transaction has been authorised by all required authoriser(s). It is waiting for Authorised Transactions,
ANZ to process the transaction. Instrument History
Processed by Bank ANZ has processed the transaction. The instrument status changes from Pending  Instrument History

to Active.

Cancelled by Bank

ANZ has cancelled the transaction after receiving it.

Instrument History

Deleted

A User in your organisation deleted the transaction before it was forwarded to
ANZ for processing.

Instrument History

Rejected by Bank

Transactions returned for customer clarification

Pending Transactions,
Instrument History

Closed

Trade Transaction has been completed in full

Instrument History
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CREATING TRADE INSTRUMENTS

WHAT HAPPENS WHEN YOU CREATE AN INSTRUMENT?

When you create an instrument, you create an Issue transaction for a particular type of trade instrument. This transaction then
progresses through the workflow shown.

After the Issue transaction, you can also create Amend Portal mail message as required.

WAYS OF CREATING INSTRUMENTS
You can create an instruments by;

> Copying from an existing instrument

> Copying from an instrument template

> Creating the instrument from a blank form

> Creating a transaction from an existing instrument.

CREATING AN INSTRUMENT
To create an instrument, complete the following steps:

STEP ACTION

1

Click the TRADE navigation button.

2 Clickthe CREATE TRANSACTION button.
The New Transaction, Step 1 page appears.

3 >select option for creating a trade instrument
> then select the Next Step button
For information about how to complete the page, click the @& button.

4 Enter details pfthe transaction. Form information about what data is required in particular fields, click the help button for the
relevant section of the page.

5 When you have finished entering the details of the transaction, click the save and close and or verify button.

CREATING AN AMENDMENT

WHAT IS AN AMEND TRANSACTION?
An Amend transaction is a transaction that you use to notify ANZ of changes to an existing instrument.

For example, if you increase the quantity of goods you are ordering, the value of the relevant Import Letter of Credit must also increase.

CREATING AN AMEND TRANSACTION
To create an Amend transaction, complete the following steps:

STEP ACTION

1

Click the TRADE navigation button.

2 Clickthe CREATE TRANSACTION button.
The New Transaction, Step 1 page appears.
3 Select the Create a New Transaction (for an existing instrument) option, then click the NEXT STEP button.
4 Select the instrument you wish to amend, then click the NEXT STEP button.
5  Enterthe amended details of the transaction.
For information about what data is required in particular fields, click the & button for the relevant section of the page.
6 When you have finished entering the details of the transaction, click the relevant button.

For information about which button to click, see the following topic in the ANZ Transactive Platform online help: Using the System
> Instrument Procedures > Working with Instruments > Working with Instruments and Transactions > Transaction and Template
Action Buttons.
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CREATING A TRACER TRANSACTION
To create a Tracer transaction for an Export Collection instrument, complete the following steps:

STEP ACTION
1 Click the TRADE navigation button.

2 (lick the Instrument History tab.
The Instrument History page appears.

3 Inthe Instrument ID column, click the Export Collection that you want to create a Tracer transaction for.
The Instrument Summary page appears for the selected Export Collection.

4 (lickthe CREATE A MAIL MESSAGE button.
The New Mail Message page appears.

5  Enter the details of the tracer request.
For information about what data is required in particular fields, click the & button for the relevant section of the page.

6 When you have finished entering the details of the trace request, click the route, save as draft and close, send to bank or cancel
new message button.

For information about which button to click, see the following topic in the ANZ Transactive online help: Using the System >
Instrument Procedures > Working with Instruments > Working with Instruments and Transactions > Transaction and Template
Action Buttons.

VIEWING TRANSACTION TERMS

To view transaction terms, see the following topic in the ANZ Transactive online help: Using the System > Instrument Procedures >
Working with Instruments > Viewing Transaction Term Details.

VIEWING INSTRUMENT TERMS

To view instrument terms, see the following topic in the ANZ Transactive online help: Using the System > Instrument Procedures >
Working with Instruments > Viewing Current Term Details.

AUTHORISING TRANSACTIONS

TYPES OF AUTHORISATIONS

> RSA Token Authorisation. Upon selecting the Authorise button for a completed transaction within ANZ Transactive, the Authoriser
will be presented with a window to enter their RSA one time password.

> Vasco Digipass Token Authorisation using SIG (Online Signing). Upon selecting the Authorise button on a completed
transaction within ANZ Transactive, the logged in user can select option 2 (SIG) on their Vasco Digipass Token - if their user profile
indicates authentication via these means. User will be prompted to enter in the six-digit Key Information as indicated on the Sign
Transaction page of the ANZ Transactive transaction. Upon selecting the arrow button, the device will return a Signature Code to
then be entered into the Sign Transaction page in ANZ Transactive

BEFORE YOU BEGIN
You can only authorise transactions if:

> the transaction has been successfully verified
> the transaction has a status of ready to authorise, or partially authorised

> your security profile includes Authorisation permissions
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AUTHORISING A TRANSACTION
Follow these steps to authorise a transaction:

STEP  ACTION
1 View the transaction
Forinstructions, see Viewing transactions
2 Click the AUTHORISE button

The system processes the authorisation request, then displays the Pending Transactions page
A message at the top of the page tells you whether the authorisation was successful.

If the authorisation was successful, the transaction is;
> changed to a status of Authorised or Partially Authorised

> listed on the Pending Transactions page if its status is Partially Authorised, or > listed on the Authorised Transactions page if
its status is Authorised (see Viewing an authorised transaction)

or
> listed on the authorised transactions page if its status is authorised (see viewing an authorised transaction)
> sent to ANZ for processing

If the authorisation was unsuccessful, the transaction;
> remains on the Pending Transactions page

> has an Authorise Failed link in the Status column (see Viewing authorisation errors)
Note: authorised means sent to the bank, partially authorised means further authorisation is required

DOWNLOADING TRANSACTION DATA

EXPORT LETTER OF CREDIT ADVICE TERMS

To simplify the document preparation process, ANZ Transactive allows you to download your Export Letter of Credit advice terms.
The default file format for this is XML, which is useful for mapping fields as you upload the information into your document
preparation system.

If you prefer, you can elect to receive these files as text (TXT) files. Text files can be edited by a wider range of applications and
so this format may be more suitable if you have to send the information on to third parties. Please contact your ANZ trade
specialist if you would prefer to receive this information in text format rather than XML format.
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Regardless of the file format, each file:

> is created from a SWIFT message for an advise transaction for an Export Letter of Credit

> contains the same data as a SWIFT MT700 message

> is created at the instrument level, and does not reflect amended terms.

DOWNLOADING ADVICE TERMS DATA FROM AN EXPORT LETTER OF CREDIT
To download advice terms data from an Export Letter of Credit, complete the following steps:

STEP ACTION

1

Click the TRADE navigation button.

2 Click the Instrument History tab.
The Instrument History page appears.
3 Inthe Instrument ID column, click the Export Letter of Credit that you want to create a download transaction data from.
The Instrument Summary page appears for the selected Export Letter of Credit.
4 Clickthe DOWNLOAD ADVICE TERMS button.
The File Download dialog box appears.
5 Select the Save This File to Disk option, then click the OK button.
The Save As dialog box appears.
6  Specify the location and file name for the file to be downloaded, then click the OK button.

The system downloads the file to the specified location.

DOWNLOADS FOR REVIEWING OTHER TRANSACTIONS

Sometimes you might want to print a copy of the data in a transaction so it can be reviewed before it is issued. This type of review
can minimize the need for amendments to a transaction. You can download a text version of the following types of transactions,
but only before the transaction is processed by ANZ:

> Issue Import Letter of Credit

> Issue Outgoing Guarantee

> Issue Outgoing Standby Letter of Credit (Detailed)

After the transaction data is downloaded, you can print the file and distribute it for review purposes. This text version contains the
most recently saved data for the transaction.

DOWNLOADING DATA FROM OTHER TRANSACTIONS
To download data from the types of transactions listed above, complete the following steps:

STEP ACTION

1

View the transaction that you want to download data from.

2 Clickthe DOWNLOAD SAVED DATA button.
The File Download dialog box appears.
3 Select the Save This File to Disk option, then click the OK button.
The Save As dialog box appears.
4 Specify the location and file name for the file to be downloaded, then click the OK button.

The system downloads the file to the specified location. You can now open it using a word processor or text editor such as Notepad.
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VIEWING DOCUMENT IMAGES

VIEWING A DOCUMENT IMAGE FROM THE TRANSACTION SUMMARY PAGE
To view a document image from the Transaction Summary page, complete the following steps:

STEP ACTION

1

Click the Transaction History Tab

2 ClicklIssue from the Transactions for this Instrument Tab
3 Clickissue for the transaction that you want to view a document image for.
4 Arethere any documents listed in the Documents section of the page?
Yes: Go to step 5.
No: There are no document images available for this transaction. End the procedure here.
5  Click the document or the PDF version to view.
The Document View page appears, showing an image of the selected document.
6  Use the controls provided on the Document View page to navigate through the document.
For information on how to use these controls, click the @& button.
7 When you have finished viewing the document image, click the Close button.

VIEWING A DOCUMENT IMAGE FROM THE MAIL MESSAGE PAGE

Some mail messages you receive from ANZ include document images. To view a document image from the Mail Message page,

complete the following steps:

STEP ACTION

1

View the mail message.

2 Inthe Related Documents section of the page, click the link to the document you want to view.
The Document View page appears, showing an image of the selected document.

3 Use the controls provided on the Document View page to view the document.
For information on how to use these controls, click the & button.

4 When you have finished viewing the document image, click the Close button.

51



This section outlines details on ANZ Transactive reports:

THE REPORTS AREA
ANZ Transactive has two options for reporting in the user’s security profile:

> Users are able to view, create or delete reports
> Users are not able to view, create or delete reports

To access the reports available within ANZ Transactive click the REPORTS navigation button. To learn more about the reports area,
see the ANZ Transactive Online Help.

STANDARD AND CUSTOM REPORTS
ANZ Transactive has two types of reports:

> Standard default reports: Standard Reports are reports provided by the bank and are classified into five different categories;
> Cash Payments
> Trade Services
> Confidential
> Administrator (Audit)
> Term Deposit.
Users who are assigned to the report categories can view, run, print and extract reports to excel, PDF or download the data.
Note: Standard Reports cannot be edited or deleted by company users.

> Custom reports: Custom reports are reports that your organisation has created, and or customised. Custom reports that you create
are only available for your organisation. All Users with report access can create and edit the custom reports that appear in the
Custom Reports Listing.

THE REPORTING PROCESS

The reporting process comprises of three stages. Note that most of your reporting activities will involve stages 2 and 3 of
this process.

STEP NAME ACTION
1 Create Create a new report from scratch, or base it on an existing report
Save the report as a:
> Custom report (available only to you)
For more information on creating reports, see Creating Your Own Reports

2 Generate  Select areport from the list of custom reports or standard reports and generate it
Generating some reports requires you to specify report criteria, such as date ranges or transaction types
For more information on generating reports, see Generating existing reports

3 Actions After generating the report you can perform various actions, such as:
> printing the report
> downloading data from the report
> deleting a customised report
> creating a copy of the report and saving it as a standard report or a custom report
> editing the report’s design

For the latest list of standard default reports available please contact your ANZ PCM or Trade Manager.
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GENERATING EXISTING REPORTS

Most of your use of the reporting function in ANZ Transactive will involve generating existing reports.

WHAT HAPPENS WHEN YOU GENERATE A REPORT
When you generate a report, ANZ Transactive:

> Retrieves the data for the report

> Prompts you for any additional report criteria, such as date ranges or transaction types

> Produces the report and displays it on the Reports page

GENERATING A REPORT
Follow the below steps to generate a report:

STEP

ACTION

1

Click the REPORTS navigation button
The Standard Reports page appears

If you want to generate a custom report rather than a standard report, click the Custom Reports tab
The Custom Reports page appears

In the Report Name column, click the report you want to generate

If the report requires you to specify any criteria, the Report Criteria page appears
Otherwise, the system generates the report and displays it on the Reports page

Which page is displayed?
Report Criteria: Specify the criteria required for the report.
Reports: The report is now ready for you to print or perform other actions (see Report actions)

If the report is not currently displayed, click the Show Report button

The system generates the report and displays it on the Reports page
The report is now ready for you to print or perform other actions (see Report actions)

REPORT ACTIONS
After generating a report, the report is now ready for you to:

> Print (see Printing a Report)

> Download data from (see Downloading Data from Reports)

> Delete customised reports (see Deleting Reports)

> Copy as the basis of a new report (see Making a copy of an existing report)

> Edit (see Editing Reports)

PRINTING A REPORT
Follow the below steps to print a report:

STEP  ACTION
1 If you haven't already generated the report, you will be required to do so
For instructions, see Generating a report
2 There are two options for printing displayed reports, you will be required to perform one of the two options below:

> Click View PDF, then from the File menu in the PDF document, select Print or
> Click View Excel, then form the File menu in the Excel document, select Print

The Print dialog box appears

Most reports produce best results when printed with a landscape orientation, so change the page layout settings so that the

report prints with this orientation
For instructions, see your web browser’s online help

Click the OK button

The report prints on your printer
If the report does not print, check your printer or network connection

Once completed, close out of the reports and return to the ANZ Transactive reports page.
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DOWNLOADING DATA FROM REPORTS

FILE FORMAT

You can download a report to your PC or network as a file in CSV format (Comma-Separated Values). CSV is a file format available
for exporting data from ANZ Transactive reports to other software packages, especially spreadsheet program. In a CSV file:

> Records are separated by carriage return/line feeds

> Fields are separated by commas

DOWNLOADING DATA FROM A REPORT
Following the below steps to download data from a report:

STEP ACTION

1

If you haven't already generated the report, generate it
For instructions, see Generating a report

2 Click the Download button
The File Download dialog box appears
3 Select the Save option, to save the report to a specific location click the OK button
The Save As dialog box appears or Select OPEN to view report
4 Specify the location and file name for the file to be downloaded, then click the SAVE button

The file containing the report data is downloaded to the specified location.
You can now open the file in your spreadsheet program

DELETING REPORTS

You can only delete the following reports:

> Custom reports that you have created

You cannot delete the following reports:

> Existing reports provided within ANZ Transactive

> Custom reports created by other Users in your organisation

WHAT HAPPENS WHEN YOU DELETE A REPORT

When you delete a report, it is no longer available on the page you previously selected it from (Standard Reports page or Custom
Reports page).

Warning: You cannot restore a deleted report, only delete reports that your organisation no longer requires.

DELETING A REPORT
Follow the below steps to delete a report:

STEP ACTION

1

If you haven't already generated the report, you will be required to do so
For instructions, see Generating a report

2 Click the Delete button
A message appears asking you to confirm the deletion of the report
3 Clickthe Yes button

The Standard Reports page or Custom Reports page redisplays (depending on the type of report you deleted), with the
deleted report no longer listed
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This section outlines details on how to create and edit your customised reports:

Using this function you can create reports and save them as custom reports.

REPORTING TOOL CONCEPTS

ANZ Transactive uses a third-party reporting tool called Web Intelligence. When using Web Intelligence to create your own
ANZ Transactive reports, you should be familiar with the following terms:

TERM DESCRIPTION

Universe  The scope of the data included in the report

You cannot change the reporting universe you are working with, as your universe is governed by the access and privileges
you have been assigned

Query The specific data included in a report

Web panel The area of the page where you define a report, as shown in the next page

THE REPORT CREATION PROCESS
The high-level process of creating your own reports contains the following stages.

For more information, see Creating new reports.

STAGE ACTION
1 Specify the data to be included in the report This involves:
> adding data to the report
> changing the order of the data in the report
> adding breaks, sorts, and sections
> inserting calculations and counts
You do this using the Results tab of the web panel

2 Set up any rules or conditions to search for only certain types of data or return values
For example, you can specify the total amount for a particular type of transactions
You do this using the Conditions tab of the web panel

3 Format the report by:
> entering a document title
> changing the font
> adjusting cell widths, colours and borders
> determining how data is displayed (for example, by including prompts)
You do this using the Settings tab of the web panel

4 Save the report as a custom report

5 Test and refine the report

If you need to make the report available to other people in your organisation, save the report as a
standard report
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CREATING NEW REPORTS

LEARNING ABOUT THE DATA YOU CAN INCLUDE IN REPORTS
When you click a data object in the web panel’s All Objects pane, a description appears under the All Objects pane

CREATING A NEW REPORT
Follow the below steps to create a customised report:
STAGE ACTION
1 Click the REPORTS navigation button
The Standard Reports page appears
2 Click the CREATE A REPORT button
The New Report Step 1 - Report Design page appears
Design the new report using the web panel
4 Click the RUN QUERY button in the top right corner of the web panel
The New Report Step 1 - Report Preview page appears
5 Are you happy with the design of the report?
Yes: Select ‘Save As’ option, Click the Next Step button; then go to step 6. The New Report/Edit Report,
Step 3 - Finalise Report page appears
No: Select‘Edit Report’ option Click the Previous Step button, then repeat steps 3 to 5
6 Enter the details required for the report, such as:

> title of the report
> description of the report
> the type of the report (standard or custom)

For information on the data required in particular fields, click the @l button
When selecting a report type, keep in mind that:

> standard reports are available to everyone in your organisation (including any subsidiaries and branches)
> custom reports are available only to you

7

Click the SAVE button
The Standard Reports or Custom Reports page appears, depending on the report type you selected in the previous step

MAKING A COPY OF AN EXISTING REPORT
Follow the below steps to make a copy of an existing report:

STEP

ACTION

1

Generate the report you want to make a copy of
For instructions, see Generating A Report

Click the Create a Copy of This Report button
The Create a Copy of This Report page appears

Enter the details required for the report, such as:
> Report Name
> Report Description
> The type of the report (standard or custom), and the reports category
For information on the data required in particular fields, click the @l button
When selecting a report type, keep in mind that:
> Standard reports are available to everyone in your organisation (including any subsidiaries and branches)
> Custom reports are available only to you

4

Click the Save button
The Standard Reports or Custom Reports page appears, depending on the report type you selected in the previous step
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After creating and refining a customised report, you can save it as a standard report if you want to make it available to other
usersin:

> Your organisation

> Any subsidiaries or branches

To do this, complete the following steps:

STEP

ACTION

1

Generate the custom report you want to save as a standard report
Forinstructions, see Generating a report

Click the Save as option
The Save as Standard Report page appears

Enter the details required for the report, such as:
> Report name
> Report description
> The type of the report (standard or custom) and the reports category
For information on the data required in particular fields, click the @l button
When selecting a report type, keep in mind that:
> Standard reports are available to everyone in your organisation (including any subsidiaries and branches)
> Custom reports are available only to you

4

Click the Save button
The Standard Reports page appears

EDITING REPORTS

Apart from creating new reports, you might also want to change the design of a report.

WHAT REPORTS CAN BE EDITED?
You can only edit:

> Custom reports that you have created

> Standard reports created by users in your organisation

You cannot edit:

> Any reports created by ANZ

> Custom reports created by other users in your organisation

If you are able to edit a report, you will notice an EDIT REPORT DESIGN button on the Reports page after you generate the report.
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EDITING A REPORT
Follow the below steps to edit a report’s design:

STEP ACTION

1

Generate the report that you want to edit
For instructions, see Generating a report

Click the EDIT REPORT DESIGN button
Note: This button only appears if you are able to edit the report
The New Report/Edit Report, Step 1 - Report Design page appears

Design the report using the web panel

Click the RUN QUERY button in the top right corner of the web panel

The New Report/Edit Report,
Step 2 - Report Preview page appears

Are you happy with the design of the report?

Yes: Select the ‘Save As’ option ; then go to step 6.
Step 3 - Finalise Report page appears

No: Select the ‘Edit query’ option and then repeat steps 3 to 5

Enter the details required for the report:
For information on the data required in particular fields, click the @ button

Click the OK button
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This section provides an overview of the cash management transaction and balance reporting available in ANZ Transactive.

REPORTING OVERVIEW

The account reporting product consists of three distinct product functions:
> Real time account balances - View up to date balances on your accounts
> Current day transactions — View current day transactions on your accounts

> Prior day reporting — Reporting on the previous day balance and transaction data

The combination of the three distinct product capabilities enables an organisation to view real time account balances prior to

creating transactions, view transactions incurred during the day, and view or print prior day account statements.

GENERAL RECOMMENDATION

It is recommended to frequently check your bank account(s) and transaction balances. Any discrepancies noticed should be

reported to ANZ.

VIEWING REAL TIME ACCOUNT BALANCES

This topic will outline the steps required to view real time account balances in ANZ Transactive.

Follow these steps to view your real time account balances:

STEP ACTION

1 Ifthe cash management area is not currently displayed, click the CASH MANAGEMENT navigation button

2 Clickthe REFRESH BALANCES button. The page will now be updated with current balances

VIEWING CURRENT DAY TRANSACTIONS

Follow these steps to view current day transactions:

STEP ACTION

1 Ifthe cash management area is not currently displayed, click the CASH MANAGEMENT navigation button

2 Inthe Account Number column, click the account you want to view
The last 50 transactions processed for that day will be displayed

VIEW / PRINT BANK STATEMENTS

Follow these steps to view prior day transactions:

STEP ACTION

1 Click the REPORTS navigation button
The Standard Reports page appears

2 Inthe report name column, click the report titled Account Statement

3 Inthe Balance Date From field, enter the from date range from when the statement data is to commence for the report
In the Balance Date To field, enter the date end date for the settlement data period
Select the account(s) to view for the date range entered.

4 (lick the Show Report button to display the report
The report is now ready for you to print or perform other actions (see Report actions)

REPORT ACTIONS
After generating a report, the report is now ready for you to:

> Print (see Printing a Report)
> Download data from (see Downloading Data from Reports)

> Save as a PDF or Excel document.
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This section provides details on the ANZ Transactive messages facility. For further details please refer to the ANZ Transactive
Online Help.

MESSAGES OVERVIEW

This function provides the ability to communicate with ANZ about a particular transaction being processed in ANZ Transactive.
To access refer to Mail and Notifications tabs in the Messages area or from the home page of ANZ Transactive.

The Messages screen appears when you click the MESSAGES button on the tool bar. From this display you can complete
the following:

> Read mail and notifications from ANZ

> Notifications examples include Export Letters of Credit Advices, Payment Advices, completed Import Letter of Credit applications
> Create and send mail to ANZ

> Route mail to a particular User in your organisation hierarchy or a particular organisation’s default User (see Organisation subsidiaries)

ANZ Transactive

rts

Ul Notifications Messages overview
CUUT ST RGN Me (and Unassigned) v

Mail Folders = 4 g Ol g i y the

[ [omsatmes  [sums |
‘AInbox (Ounread) — S
|| Drafis (0} T 05Jul 2009 04:58AM  Correspondence: DS5055/1166 Sunshine Trading Company Pte Ltd
|_| Sent to Bank (0)

-1 (1 Total) Page 1

TYPES OF MESSAGES
The Messages screen has two tabs: Mail and Notifications. Each tab relates to a different type of message:

Mail messages are:

> Messages sent from ANZ that require action from your organisation

> Messages sent to ANZ

> Messages that have been routed to you from another User in your organisation hierarchy

ANZ Transactive

Itemns 1-1 (1 Total} Page 1

Mail folders

(see Organisation subsidiaries)
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AN EXAMPLE OF A MESSAGE IS SHOWN BELOW

Notification is an advice sent from ANZ that reports the status of a transaction it has processed for your organisation. Based on
registration requests received by your organisation, ANZ will provide notifications according to the requested configuration.

Notifications are for information purposes only and do not require action from anyone in your organisation.

[J 21 Apr 2010 12:00PM
[ 21 Apr 2010 12:00PM
[ 21 Apr 2010 12:00PM
[ 21 Apr 2010 12:00PM
[ 21 Apr 2010 12:00PM
[ 21 Apr 2010 12:00PM
[ 21 Apr 2010 12:00PM
[ 21 Apr 2010 12:00PM
[ 21 Apr 2010 12:00PM
[ 21 Apr 2010 12:00PM

" [oweatme =

ANZ Transactive

Reports e Data

LX1149758110 Export LC

T1669058110 Transfer Between Accounts
1X1149748110 Export LC
1X1149748110 Export LC
1X1149748110 Export LC
11668378110 Transfer Between Accounts
P1668368110 Payment

GOP1667918110  Outgoing Guarantee
GOP1667908110  Outgoing Guarantee
P1668478110 Payment

Cash Management Subsidi; cess

Notifications

Doc Examination
Issue

Payment

Doc Examination
Advise

Issue

Shown below are transaction notifications (either Processed, Rejected, Cancelled, Rejected Payment or Partially Rejected Payment) for:

Click on the column headers below to sort the data in ascending or descending order (indicated by

Tinks Pty Itd

Transactive (Training Only)
Tinks Pty Itd

Tinks Pty Itd

Tinks Pty Itd

Transactive (Training Only)
Disneyland - Hong Kong
Disneyland - Beijing
Disneyland - Shanghai

‘Osama Smith

usp
AUD
usp

60,000.00
100.00
2,000.00
2,000.00
500,000.00
600.00
350.00
55,000.00
45,000.00
30,000.00

Processed by Bank
Processed by Bank
Processed by Bank
Processed by Bank
Processed by Bank
Rejected by Bank
Rejected by Bank
Rejected by Bank
Processed by Bank

Processed by Bank

Results: of 42 Total

WORKFLOW OVERVIEW

Messages move through ANZ Transactive, starting from the time that the message is either:

> Received from ANZ (incoming message)

> Created in draft form (outgoing message or response)

As part of the workflow of a message, any authorised User can use the route message functionality to route incoming or outgoing
messages in the Mail page to:

> A particular User in a related organisation (see Organisation subsidiaries)
> A particular related organisation, which results in the message being routed to the selected organisation’s default User
Messages that appear in the Notifications page cannot be routed to other Users or organisations.

The Mail page indicates the person to whom the message is currently assigned. This person is generally either:

> The person to whom the message has been routed

> The person who last took action on the message

Portal mail messages received from ANZ are unassigned, however you may assign them to a User or organisation by routing them

as required.
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FOLDERS
Messages on the Mail page are arranged into folders to help organise the messages that either:

Require an action or response from your organisation, OR

Are in draft form pending submission to ANZ

The table below summarises the contents of each folder in the Mail page. Please note that you cannot create additional folders or
change the names of the standard folders.

FOLDER DESCRIPTION

Inbox Contains messages that have been either received from ANZ or routed by another organisational User that

requires attention. In the event messages are deleted within this folder, the message will remain with the
related transaction in the Payment Transaction History tab

Drafts This folder also contains messages that have started and saved as a draft

In the event a draft message is deleted, the message will no longer appear within the system
Once the draft message have been completed and sent, the message will move to the Sent to Bank folder

Sent to bank Contains messages that have been sent to ANZ. After messages in this folder are deleted, they remain with

the related transaction in the Payment Transaction History tab

NNT ANZ Transactive

T Notifications

Show mail for; LUXCUERY

_VInbox (Qumread) —
1 Drafts ()
] Sent to Bank (0)

Mail Fold: nn he: 50 ] w the red

Vendor ID

MESSAGE LOCKING

When more than one User in an organisation is given the ability to create and reply to mail messages, sometimes two Users
might try to update the same message or response simultaneously. To ensure data integrity of the message, ANZ Transactive
uses message locking.

With message locking, only the first User to save changes to the mail message or response will be successful; any other User who
has simultaneously opened the message or response must:

Cancel their changes

Wait until the first User closes the message before reopening the message or response and re-entering their changes

VIEWING MESSAGES

Follow these steps to view an existing message:

STEP ACTION

1

If the Messages area is not currently displayed, click the MESSAGES navigation button
Once the Messages tab is displayed, select the Mail tab if not already active

2 Click one of the Mail Folders on the left side of the Mail page, depending on the type of mail messages
you want to view
3 Inthe Subject column, click the message you want to view
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VIEWING NOTIFICATIONS
Follow these steps to view notifications:

STEP  ACTION
1 If the Messages area is not currently displayed, click the MESSAGES navigation button
The Messages area displays with the Mail tab active

2 Click the Notifications tab
Click the Notification you want to view in either the Instrument Id or the Transaction Column

3 This will display the Transaction Summary History screen.
Click Issue in the transaction to view the terms entered or click the Advice link or PDF link to view the attached letter.

CREATING AND SENDING MESSAGES

DRAFTING MESSAGES
Follow these steps to draft an outgoing message to ANZ:

STEP  ACTION
1 If the Messages area is not currently displayed, click the MESSAGES navigation button

2 Click the Create a Mail Message button. The New Mail Message page appears

3 Enter the details of the message
For information about what data is required in particular fields, click the @l button

4 Click the Save as draft & Close button to save the message as a draft to send or route later
The message is saved and the New Mail Message page closes

Note: Instead of saving the message as a draft, you can also send it to ANZ (Send to Bank button) or route the message within
your organisation subsidiary via the (Route button)

These subjects are discussed separately in the following sections

SENDING MESSAGES TO ANZ
Follow these steps to send a message to ANZ:

STEP  ACTION
1 Display the message you want to send. You can do this by either:

> Viewing an existing message (see Viewing a mail message)
> Drafting a new message (see Drafting messages)
> Creating a mail message (see Creating a mail message)
2 Click the Send to Bank button
The message is sent to ANZ and the Mail Message page closes

ROUTING MESSAGES WITHIN YOUR ORGANISATION HIERARCHY
Apart from sending messages to ANZ, you can route mail messages to:

> A particular User in your organisation subsidiaries (see Organisation subsidiaries)
> A particular organisation’s default User
When doing this, you can route either:
> A single message from the Mail Message page
> Multiple messages from a particular message folder

For instructions on how to route messages, see the following topic located in the online help:
Using the System > Messages Procedures > Routing Mail Messages.

© Copyright Australia and New Zealand Banking Group Limited (ANZ). ABN 11 005 357 522. ANZ is a trademark of ANZ. All other trade marks and products are either trade marks or
registered trade marks of their owners. This document is provided to you on a commercial-in-confidential basis and must not be disclosed to any person outside of your organisation
without express written permission of ANZ. The information contained in this guide is intended as general information only. The guide is subject to change without notice.
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